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Preamble 
 
Thank you for downloading Quick Devis® Free Edition. 
 
Quick Devis® Free Edition is intended for building estimates in all spheres of activity that require 
handling of material and workforce. It was designed to build estimates than contain up to 3 different 
kinds of workforce (for example: design, workshop and building site) and that comprise up to 250 
lines in the ‘Bill of Quantity’ frame (each may contain up to 10’000 lines). 
 
If your needs in estimates require more precision or if your estimates can reach require more than 
250 lines in the ‘Bill of Quantity’, consider trying Quick Devis® Enterprise Edition which allows 99 kind 
of materials, 99 kind of workforce, up to 32’700 lines in the ‘Bill of Quantities’ frame and a multitude of 
user definable fields which allow adapting the product to most estimating methods. 
 
The use of Quick Devis® Free Edition is completely free and requires only registration on our web 
site. This implies that no technical support will be provided by telephone. Please email any request 
for support to support@quick-devis.net in English or French language. IAES does not guarantee 
deadlines for supports related to the Free Edition. 
 
If your needs in terms of support require guaranteed times, thank you to purchase Quick Devis® 
Enterprise Edition (available on www.quick-devis.net) which comes with a maintenance contract.  
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Copyright 
 
Quick Devis® Free Edition is edited by IAES sarl - 15, allée Buffon – 94700 Maisons Alfort (France) 
 
Any data contained in this manual can be modified without notice. The brands, names, amounts, 
coefficients and parameters are only used as examples and are fictitious. 
 
Quick Devis® Free Edition and its documentation cannot be reproduced, even partially, whatever the 
method, without prior written consent of IAES. It is also prohibited to reverse whole or part of the 
program to understand its operation. 
 
Quick Devis® is a registered trade mark. Copyright© Quotalys 2002-2005 all rights reserved - © 
IAES 1991-2001. The rights on Quick Devis® Free Edition and its documentation belong exclusively 
to IAES. 
 
Various trade marks are mentioned in Quick Devis® Free Edition or in its documentation: 
 

Formula One is a trade mark of Tidestone Technologies Inc 
IBM, PC and PS are trade marks of International Business Machines Corporation 
Windows, Excel, Word, Access, Visual Basic, Visual C++ are trade marks of Microsoft 
Corporation. 

 
Generally the brands mentioned are properties of their respective companies. 
 
To get further information about distribution of Quick Devis®, please contact: 
 

support@iaes-software.com 
sales@quick-devis.net 
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License 
 
By installing Quick Devis® Free Edition, IAES gives you the right to use a copy of the software. This 
right is neither exclusive, nor transferable. You can install Quick Devis® Free Edition on as many 
computers as you wish but you must register your license on line from each computer. 
 
Quick Devis® Free Edition user’s manual and the software which comes with it are provided “just as 
is” without any explicit or implicit guarantee. In spite of the efforts made to provide documentation as 
exhaustive as possible and to publish software as reliable as possible, certain functions may not have 
been sufficiently developed or some errors may appear. 
 
In any case, IAES or its local dealers could not be held responsible for any direct or indirect damage 
resulting from a defect of the software or of its documentation. 
 
Some countries or states may restrict the above warranty limitation. In such case, the user is invited 
to uninstall Quick Devis® Free Edition if this limitation does not satisfy him. In the event of litigation in 
respect of the software warranty, whatever the address of the plaintiff, French law will apply and must 
be instituted in the commercial court of Creteil (France). 
 
Important: By installing Quick Devis® Free Edition you agree with all of the clauses in this manual. If 
you disagree with any clause, please, do not install Quick Devis® Free Edition. 
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Installing Quick Devis® Free Edition 
 
Quick Devis® Free Edition is not distributed on physical media; it is only available for download on 
www.quick-devis.net. It can be downloaded for free. It only requires registration. 
 
Before installing the product, we advise you to read this chapter in order to get optimum results from 
Quick Devis® Free Edition. 
 
Quick Devis® Free Edition was designed to run under Microsoft Windows 2000, Microsoft Windows 
XP or Microsoft Windows 2003. 
 
The basic recommended configurations to run Quick Devis® Free Edition are as follows: 
 

IBM PC/PS compatible with Pentium III 700 MHz processor 
128 Mb of RAM 
50 Mb free on hard disk 

 
These configurations are the minimum recommended to get acceptable performances. Quick Devis®, 
can nevertheless be run on slower configurations. However, the application will be particularly slow 
and the disc requests to emulate virtual memory will be frequent; the stability of the program could, 
then be affected. 
  
The disc size specified is the approximate size needed for the program. The estimates and the 
databases being bulky files, it is recommended to have more size for a “comfortable” usage. 
 
To install Quick Devis® Free Edition, launch the file qd607fe.exe which you can download from 
http://www.quick-devis.net 
 
When the installation program is launched, simply follow the given instructions which appear on the 
screen. 
 
When Quick Devis® is completely installed, the following menus are accessible: 
 

Quick Devis® Free Edition                                     
Uninstall Quick Devis® Free Edition               

 
The group of program containing these icons automatically appears in the ‘Start’ menu. This group is 
named ‘Quick Devis® V6’ and can be found in Window’s ‘Programs menu’. 
 
If you do not own administrator rights on your computer, we recommend opening a session in ‘admin’ 
mode before launching the installation program because your user profile may be programmed to 
refuse the registration of new components. Contact your administrator for more information. 
 
If you installed Quick Devis® Free Edition and the above menus do not appear in the ‘Start’ menu, it 
is probably because your computer requires ‘admin’ rights to install Quick Devis® Free Edition. In 
such case, remove the software, get the rights and reinstall it. 
 
To always profit from the latest updates, Quick Devis® Free Edition checks for new versions each 
time you launch the program. A little window will appear at the bottom right of the screen if a new 
version is available. You just have to click this window to update your program. 
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Quick Devis® Free Edition cannot be installed on the same computer as Quick Devis® Enterprise 
Edition. If you install one version, it will replace the other automatically. 



Quick Devis® Free Edition                                                                                                               User’s Manual 
 

Quick Devis® Free Edition © IAES (1991-2006)                                                                                   Page 11/105 

Who is this manual for? 
 
This user’s manual is intended for users not having any preliminary knowledge of the product and 
having taken part in no training session. The user’s manual does not explain what an estimate is but 
simply the methods of construction and evaluation of the estimates under Quick Devis® Free Edition. 
 
A basic knowledge of your operating system is assumed for correct use of the software because the 
user's manual does not instruct on the practices of the system’s tools, for example: the window for 
opening or recording a file, the window for selecting a colour, etc. For more information consult the 
user’s manual of your operating system. 
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Meaning of the terms 
 
Before approaching Quick Devis® Free Edition, it is important to determine the meaning of the terms 
employed in this user’s manual and in the program itself. 
 

B.o.Q: “Bill of Quantities” indicates the frame which is transmitted to the customer; it is also 
often called “Customer’s view” or “Customer’s frame”. It is the first retail level of an estimate. 
 
Detailed view: “Detailed view” indicates the detail of a single task of the ‘B.o.Q’; it is in the 
“detailed view” that you will enter material costs and times associated to workforce. 
 
Nomenclatures: “Nomenclatures” indicates a view of the estimate reclassified according to 
various sorting criteria (Manufacturers, Families, etc…) 
 
Overhead expenses datasheet: “Overhead expenses datasheet”, “Overhead costs datasheet” 
or “Environment” indicate the worksheet which allows entering the duties which are not 
quantified in the “detailed view” such as the gantry facilities expenses. It is also in the 
“Overhead expenses datasheet” that you will calculate the margins and enter the workforce 
rates. 
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License registration 
 
When launching Quick Devis® Free Edition for the first time, you will be prompted to register your 
license. You can delay this registration by clicking the “Remind me after 3 days” button. 
 

 
 

To register your license, click the “Register” button and complete the registration Web form. The data 
will only be used to build statistics and to improve the quality of support. IAES warrants the 
confidentiality of collected data. 
 
You have to be connected to the Internet to register your license of Quick Devis® Free Edition. 
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Configuring Quick Devis® Free Edition 
 
Immediately after the registration, Quick Devis® Free Edition prompts you to configure the program 
to match your needs as well as possible. The configuration wizard helps you define the directories 
which will be used to store your estimates and various other elements and building the model you will 
use for your future estimates. 
 
You will be able to make changes in the configuration built in this chapter at any time by calling the 
“Configure an estimate” function of the menu “?”. 
 

 
 
When this message appears, click the “Next” button to start configuring Quick Devis® Free Edition. If 
the message does not appear, click “Configure an estimate” in the menu “?”. 
 

 
 
When the above window appears, click the “Set up” button to point out the directories you want to 
use as default directories to store your estimates, your standard mails frames and your databases. 
 
If the need arises, you can create these directories at the time of their definition using the appropriate 
functions of the selection window. 
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When all the directories are correctly set, click the “Ok” button to record them. Then, click the “Next” 
button located at the bottom of the “Initial configuration” window. 
 
Important: Under Quick Devis® Free Edition, the database directory cannot be located on a network 
device because this version does not handle database sharing. Consider using Quick Devis® 
Enterprise Edition if you plan to share databases. 
 

 
 
Provide a filename and a directory name for the database which will contain the list of your customers 
and click the “Save” button. Then click the “Next” button. Quick Devis® Free Edition will automatically 
create your customer’s database. 
 
Note: If your customer’s database was already created during a previous session of Quick Devis® 
Free Edition, click the “Next” button. 
 

 
 
The following step consists in naming the first estimate which will be used as a model for your future 
estimates. It is recommended to create a specific directory to place your models in order to avoid 
mixing them with your future estimates. 
 
A model is a standard estimate, generally empty of rows but containing the various specific usual 
settings to your environment (workforce rates, colours, currency rates, comments, etc.) 
 
When your model is named, click the “Save” button to create it. Then, click the “Next” button. 
 
You will be able to make changes later in your model by opening it simply as if it was a standard 
estimate. 
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Provide the most current VAT rate you will display at the bottom of your estimates and check the box 
if you wish that this rate appear in your selling price editions. 
 
Click the “Ok” button accept and then, the “Next” button. 
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Now define the background colour you wish to use in your B.o.Q. for the cells corresponding to 
“tasks” and the background colour of the headings of B.o.Q. 
 
These colours are these of your work environment. Not those of the customer’s editions which could 
be customized for each edition. 
 
Click the “Ok” button to accept and then, the “Next” button. 
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You can then define the shape of the detailed view which will be used to enter expenses in order to 
adapt it to you usual methodology. 
 
The columns appear in the order they are posted in the right side list. To change the order, you can 
move these columns within the list using drag and drop (click on the column to be moved and move it 
while keeping the left mouse button pressed – then, release the button on the new location). To hide 
a column, select it in the right side list and click the “Hide column” button. If you select a column in 
the left side list, you can display it by clicking the “Show column” button. 
 
The colours, widths, number formats and alignment of the columns can also be specified while 
clicking on the column to be parameterized in the right side list, then on the appropriate buttons and 
lists of the “Column properties” window. 
 
The font name used in the detailed view and the colour of the horizontal bands appearing in the top 
and bottom of each task can be specified using the lists and buttons of the “Global settings” window. 
 
Click on the “Ok” button to accept your configuration then the “Next” button which is located at the 
bottom of the “Initial configuration” window. 
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If you plan to handle several currencies within your estimates, you will have to specify for each one 
their 3 letter codes and the values of the new currencies expressed in the reference currency (or the 
values of the reference currency expressed in the new currencies). 
 
The reference currency is that in which you plan to give your proposals. If you need to change it, click 
on its code in the “Currency” column, next to the word “Reference” and select the new reference 
currency. 
 
Click the “Next” button to continue configuring your model estimate. 
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Now define the various categories of workforce which you wish to use in the estimates to be derived 
from your model. You can define up to 3 different categories with Quick Devis® Free Edition. 
 
If you need more kinds of workforce, consider purchasing Quick Devis® Enterprise Edition which lets 
you define up to 99 kinds of workforce per estimate. 
 
To specify a kind of workforce, fill the columns appearing in yellow. The columns “Currency” and 
“Time unit” can be specified using drop-down lists. If you choose a specific unit of time to express 
your kind of workforce, you may have to specify also the quantity of hours appearing in this unit. 
 
In the example above, we have defined resources for “Site worker”, “Designer” and “Project’s 
manager” expressed in euros. The designer and the project’s manager are expressed respectively in 
days and months; it is computed at 8 hours per day and 168 hours per month for these resources (it 
can be altered to suit your needs). 
 
When your workforce resources are defined, click the “Next” button located at the bottom of the 
“Initial configuration” window. 
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Now you will just have to specify the various overhead costs you may want to see in the estimates 
derived from you model as in the example above (“Gantry facilities” and “Cranes”). You can express 
these expenses by formulas which can depend on the amounts of material or on the workforce times 
centralized in the sheet. 
 
Note: If you need to set up your own coefficients calculations or to define your particular datasheets, 
consider purchasing Quick Devis® Enterprise Edition which has 20 free sheets allowing to integrate 
any calculation using the Microsoft Excel format. 
 
Click the “Next” button to terminate the configuration of your model. 
 

 
 
On more click on the “Next” button proposes the following message: 
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You can then click the “Close” button to leave the configuration tool and to create your first estimate 
derived from the model created or click “Open sample” button to visualize a standard estimate (which 
will not inherit the specific parameters from your model). 
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Creating an estimate 
 
To create a new estimate, simply click the “New estimate” function in the “File” menu or click the 
button . 
 
Provide then a file name and a location. You will get an estimate which conforms to the model built in 
the previous chapter or an empty estimate if you did not parameterize any model as a preliminary. 
 

 
You should now build the bill of quantities using the buttons . These buttons respectively create 
a task on the same level as the cursor is (B if the cursor is on A for example) and create a sub-task 
immediately under the task on which the cursor is (A.1 if the cursor is on A for example). In this last 
case, “A” which was a task becomes a branch. 
 
If you make errors, you can use the button  to erase a task or a branch; select the task or branch 
to be deleted first. 
 
You can manually change the proposed items by entering directly the desired text in the “Item” 
column. You can specify the columns “Description”, “Unit” and “Quantity” in the same way. 
 
If you need to insert lines under the tasks to add comments or to copy an existing form, use the 
“Insert row” and “Remove row” functions from the “Edit” menu. 
 
When you finish the configuration of your B.o.Q. you can reindex your estimate in order to optimize 
calculations and check its integrity by clicking the button . 
 
The functions of the B.o.Q. view are described in an exhaustive way in the chapter The Bill of 
Quantities. 
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Common functions 
 
Many functions of Quick Devis® Free Edition are accessible from most of the views and have a 
similar behaviour whatever the view in progress is. These functions are described below: 
 

New estimate  “File” menu 
 
This function lets you create an empty estimate or an estimate in conformity with one of the 
models defined using the “Configure an estimate” function of the “?” menu. To allow creation, 
you will have to provide a file name for the new estimate. 
 
If, using the function “Configure an estimate”, you defined several models; a window will 
prompt you to select the model to be used when calling this function. 
 
Open estimate  “File” menu 
 
This function lets you open an existing estimate file. The estimates will have as a .DVZ suffix 
or .DEV suffix. 
 
The first are compressed estimates with .ZIP format, the seconds are expanded estimates with 
Microsoft Access format.  
 
For further information on the differences between .DEV and .DVZ files, read the chapter The 
formats of estimates files in this manual 
 
When you create a new empty estimate, an expanded file (.DEV) is automatically created; it is 
then transformed into a compressed file (.DVZ) with the first recording. 
 
If you wish to open an estimate file under Microsoft Access, you will have to first expand it if it 
is a .DVZ file. To do that, use the function “Compact and expand tools” form the “Tools” menu. 
 
Close estimate “File” menu 
 
This function lets you close the current estimate. You will be prompted for recording if 
requested. 
 
Save  “File” menu 
 
This function lets you record on disc the current estimate under its original name. For further 
information on the principles of recording used by Quick Devis® Free Edition, read the chapter 
The safety of the estimates in this manual. 
 
Save as  “File” menu 
 
This function lets you record on disc the current estimate under a name different from its 
original name. For further information on the principles of recording used by Quick Devis® 
Free Edition, read the chapter The safety of the estimates in this manual. 
 
Print area  “File” menu 
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This function lets you set the print area according to the selected cells when calling the 
function. It can be used in the “B.o.Q.” view and the “Overhead sheet” view. 
 
You can also manually change the print area using the “Page setup” function. 
 
Page setup  “File” menu 
 
This function lets you define the various usual parameters of page-setting. However, not all 
settings are valid for all the views. 
 
Certain editions, in the B.o.Q. view, are already parameterized and some of their settings 
cannot be changed. 

 
Print preview  “File” menu 
 
This function lets you visualize on the screen the printout according to the current print area 
and page settings. 

 
Report generator  “File” menu 
 
This function launches the reports generator which lets you produce different formats of the 
reports. The functionalities of the report generator are described in the chapter The Reports 
Generator in this manual. 
 
Access databases  “Data” menu 
 
This function lets you open the databases. Its operation is described in the chapter The 
Articles Manager in this manual. 

 
Ms Word mail  “File” menu 
 
This function lets you access the automated Microsoft Word templates which use data from 
the management tools. Its operation is described in the chapter Automated mails in this 
manual. 
 
This function requires Microsoft Word 97 or greater. 

 
Export Ms Excel  ”File” menu 
 
This function lets you export the current view to Microsoft Excel. Data exported according to 
views are as follows: 
 

• B.o.Q: All columns and all rows 
• Detailed view: The current task or the current selection 
• Nomenclatures: The entire nomenclatures or the current selection 
• Overhead sheet: The entire workbook 

 
This function requires Microsoft Excel 97 or greater. 
 
Declaring estimate  “Tools” menu 
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This function lets you specify various customers’ information in order to use them in the report 
generator and the automated templates. Its operation is described in the chapter Managing 
estimates. 
 
Calculate  “Calculation” menu 
 
This function computes data in the current view without running a global recalculation. This will 
be useful if you handle important estimates on weak computers: it will avoid computing the 
entire estimate when, for example; you simply need to refresh the overhead sheet data. 
 
Calculate SP  “Calculation” menu 
 
This function lets you compute the entire estimate (the costs and the selling prices); it 
refreshes all the views. Use it if the mention #N/A appears in the columns of the B.o.Q. in 
order to display a valid statement. 
 
Reindex the estimate  “Tools” menu 
 
This function lets you rebuild the estimate from the data stored in memory and on the disc; it 
also checks the integrity of the estimate. You will call it if a message invites you to do so after 
the detection of an anomaly in the estimate. It is a safety measure to call the function when 
you finish an estimate in order to guarantee its integrity. 
 
Quick Devis® Free Edition has algorithms which control the integrity of the estimate each time 
a recalculation is launched and before every printing request. However, if you obtain an error 
message when recalculating or when printing, first try to reindex your estimate. 

 
Settings of detailed view or nomenclatures  “Options” menu 
 
This function lets you define the order, the format and the colours of the columns displayed in 
the detailed view or in the nomenclatures. 

 

 
 

The definition is specific to the detailed view or to the nomenclatures according to the view 
from which the function was called. The presentation of the detailed view can be different from 
that of the nomenclatures. 
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In the window above, you can see on the left side the hidden columns which are available to 
be displayed and on the right side, the displayed columns shown in the order they are posted.  
 
To add a column, select it, in the left side list and click the “Show column” button “. To remove 
a column, select it in the right side list and click the “Hide column” button. 
 
To change the order of the columns, click on the column to be moved in the right side list, keep 
the left mouse button pressed and move the column to its new location. Then, release the 
mouse button. 
 
To restore default view, simply click the “Restore default display settings” button. 
 
You can change the format of most of the columns by clicking the “Format numbers” list after 
having placed the cursor in the right side list on the column to be formatted. You can operate 
in the same way for alignment and width (this last value can also be set, moving the column 
separators in the detailed view or in the nomenclatures) 
 
To assign a specific colour to a column, click on the column in the right side list and click the 
“Background colour” area. You can also change the colour of the strips being displayed in the 
top and bottom of each task by clicking the “Background colour B.o.Q.” area. 
 
New estimates settings   “Tools” menu 
 
This function lets you append up to 100 models of estimate which will be used as a basis for 
the new estimates to be created. A model estimate is a parameterized estimate with its 
currencies, colours, rates etc; the model will be automatically duplicated to a new estimate at 
the time of creation. That is exactly as if you loaded the model file and recorded it under the 
new name. 
 

 
 

If you place more than one estimate in this list, Quick Devis® Free Edition will prompt you, for 
each creation of estimate to specify from which model the new estimate must be derived. If 
only one estimate remains in the list, Quick Devis® Free Edition will create a new estimate in 
conformity with the model without prompting the user to select it. 
 
If you do not specify any estimate in the list, Quick Devis® Free Edition will create an empty 
estimate with the standard formats and it will then be necessary to provide all its settings. You 
also can load these parameters from another estimate using the “Get settings from another 
estimate” function. 
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To add an estimate to the list, click the “Append file” button and select the estimate to be 
appended. To remove an estimate from the list, select it first and click the “Remove the file” 
button. 
 
It can sometimes be interesting to associate to the model a more explicit text than the name of 
the model file. To do so, click delicately on the file name in the list and enter the text you wish 
to substitute it with. If after that you want to retrieve which file name is associated to the text, 
use the horizontal scroll bar to see the right side of the list. 
 
Get settings form another estimate  “Tools” menu 
 
This function is particularly useful to configure an estimate according to another and 
particularly to pick the parameters in a model. Most of the parameters can be loaded, including 
the overhead sheets. 
 

 
 

You must provide the source estimate name by clicking in the “From the estimate:” list box and 
then select the data you wish to import by checking the appropriate boxes. 
 
You can thus create empty estimates and import your working environment from a model. 
However, it is easier to declare your model estimate using the “New estimates settings” in the 
“Tools” menu. This way, the new estimates created will inherit automatically their parameters 
from your model. 
 
Compact current estimate  “Tools” menu 
 
This function lets you optimize the current estimate in order to reduce its size and to speed up 
its calculations. 
 
Repair current estimate  “Tools” menu 
 
This function lets you repair the current estimate. Call it if Quick Devis® Free Edition reports 
that the estimate is damaged. If the repairing process fails, close the estimate and try to repair 
it calling the “Repair an estimate or a database” function in the “Tools” menu. 
 
Compact an estimate or a database  “Tools” menu 
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This function lets you optimize an estimate or a database in order to reduce its size and to 
increase the speed of access to it. Quick Devis® Free Edition automatically creates a backup 
copy of the old version. It will prompt you to delete this copy at the in end of process. 
 
Delete an estimate or a database  “Tools” menu 
 
This function replaces the standard functions of the operating system to let you delete an 
estimate or a database directly from Quick Devis® Free Edition. You cannot remove an 
estimate or a database which is in use. 
 
Repair an estimate or a database   “Tools” menu 
 
This function lets you repair an estimate or a database which could not be opened for 
example. Quick Devis® Free Edition automatically creates a backup copy of the old version. It 
will prompt you to delete this copy at the in end of process 
 
If you repair an estimate, you will be prompted to destroy the B.o.Q. sheet and the overhead 
sheet. Check the associated boxes only if the repairing process fails. Quick Devis® Free 
Edition will automatically recreate the deleted sheets form their image in the file when opening 
the estimate. 
 
Compact an estimate  “Tools” menu 
 
The compression of the estimates is managed automatically and the compression is made 
when recording the estimate. However, if you need to manually compress a .DEV file to a 
.DVZ file without having to open it, you can use this function and simply provide the name of 
the file which must be compressed. 
 
Expand an estimate  “Tools” menu 
 
The compression of the estimates is managed automatically. An estimate having a .DVZ suffix 
is stored in a compressed format whereas an estimate having a .DEV suffix is expanded. If 
you need to read the contents of an estimate under Microsoft Access, you will have to expand 
it. Then, use this function and provide the name of the file to be expanded. 
 
Performance and safety  “Tools” menu 
 
To change the settings this function must be called when no estimate is open. If an estimate is 
open, the function displays the file name of the image of the estimate in the cache directory. 
 

 
 

In order to accelerate the calculations and to guarantee an optimal safety, the estimates are 
always stored on a local disk drive while they are open. This disk drive must be as fast as 
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possible. In the “Disk unit” list box, you can choose the cache location and place it in the root 
of the disc or in the user’s profile. Choose this last option if several users with different profiles 
have to work on the same computer. 
 
In order to allow restoration of previous data of any estimate, Quick Devis® creates a safety 
stack whose size (expressed as a number of estimates) can be specified. When the stack 
reaches the specified value, the oldest estimate is deleted and replaced by most recent (First 
In/First Out). The larger the stack, the better the safety. On the other hand, the space occupied 
on the disc is more important. 
 
If you do not know how to use these parameters, let Quick Devis® Free Edition determine 
them according to your system (default values). You can reset the automatic parameters by 
clicking the “Restore the default values” button. 
 
Recover an estimate  “Tools” menu 
 
This function lets you recover and estimate from its track; to recover an abnormally closed 
estimate or to recover the old version of an estimate which would have, for example, been 
optimized. The function has three lists: 
 

• Last files used or repaired 
• Last files before recovery 
• Last recorded files 

 
Each time you record an estimate, Quick Devis® Free Edition leaves a track in the “Last 
recorded files” list. You can recover these tracks by reaching the corresponding list and 
clicking the “Restore the file” button. 
 
The tracks of the last files used appear in the leftmost list and thus allow you to recover a file 
even if you did not save it intentionally because any file that crosses the cache directory leaves 
a track in this list. 
 
Lastly, if Quick Devis® Free Edition automatically recovered files following a power supply 
failure for example, the original estimates (before repair) are stored in the second list to allow 
recovery. 
 
If you wish to empty the lists to free space on your disc (by thus losing temporary safety), click 
the “Kill all files” button. You can also erase the files one by one by selecting them and clicking 
the “Delete the file” button. 
 
Upgrade QD from the Web  “?” menu 
 
Use this function to update your Quick Devis® Free Edition with the latest available version. 
The function must be called when no estimate is loaded because the update requires the 
closing of the program. 
 
If you to are connected permanently to the Internet, you do not have to call this function 
because Quick Devis® Free Edition automatically detects the presence of updates and 
proposes to upgrade the program if an update is available. Click the information window which 
appears at the bottom right of your screen. 
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The Bill of Quantities 
 
When your B.o.Q. is configured, you obtain an estimate like the one shown below (example). You 
can also open the sample estimate provided with Quick Devis® Free Edition located installed in the 
directory you selected to store the estimates when configuring the program. 
 

 
 
In the estimate above, you can see a tree structure containing 3 overlapping levels corresponding to 
tasks, totals and sub-totals. Quick Devis ® Free Edition can handle up to 8 overlapping levels in 
depth. 
 
A Bill of Quantities generally consists of a spreadsheet associated with a tree structure which carries 
the chapters, sub-chapters and the tasks (which are detailed in the “detailed view”). 
 
To build a B.o.Q. you can use the following functions that appear in the “Organization” menu: 
 

New task  “Organization” menu (shift + F4) 
 
This function lets you create a new task under the task on which the cursor is. The task thus 
created is placed on the same overlapping level as the task from which the function was 
called. 
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You cannot create more than 253 tasks in the same branch. 
 
New sub task  “Organization” menu (shift + F5) 
 
This function lets you create a new sub-task which will be placed at the overlapping level 
immediately after the one where the cursor is. The initial task becomes automatically a branch 
which handles the new sub-task created. 
 
If the task on which the cursor was at the time of the call contained detailed rows, these rows 
are automatically transferred in the new sub-task. 
 
You cannot exceed 8 overlapping levels. 
 
Remove task or branch  “Organization” menu (shift + F6) 
 
This function lets you remove a task or a whole branch. It applies to the task (or the branch) on 
which the cursor is. The destruction is irreversible and all data connected to the task or the 
branch are removed (even the contents of the “detailed view”)  
 
Copy a task or a branch  “Organization” menu (shift + F11) 
 
This function lets you copy to the internal clipboard, the task or the branch on which the cursor 
is. All data relating to the selected task or branch are copied to the clipboard, including the 
rows that compose the detailed view. 
The function also copies the part of spreadsheet corresponding to the copied tasks, including 
their colours, sizes and font names. 
 
The internal clipboard is kept permanently in the user’s profile; so that it remains available for 
the following sessions of Quick Devis® Free Edition. 
 
The function authorizes the copy of data within the same estimate but also lets you pass data 
from one estimate to the other if you open several estimates simultaneously. 
 
Cut a task or a branch  “Organization” menu (shift + F10) 
 
This function is strictly identical to the function “Copy a task or a branch” except that it deletes 
the task or the branch after the copy is made. This function cannot be cancelled. 
 
Paste a task or a branch  “Organization” menu (shift + F12) 
 
This function lets you paste the tasks or the branches previously placed in the internal 
clipboard using the “Copy a task or a branch” and “Cut a task or a branch” functions. All data 
relating to the task or the branch stored in the clipboard are pasted in the estimate at the 
cursor position, including the rows composing the detailed view, the colours, the sizes and the 
font names. 
 
You can paste the task or the branch below the cursor position (same level) or as a child of the 
branch where the cursor is (next level). 
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If the colours, sizes and font names were different in the source estimate and in the target 
estimate, it is recommended that you reindex after calling this function in order to restore the 
homogeneity of the attributes across the estimate. 
 
The function authorizes the pasting of data within the same estimate but also lets you pass 
data from one estimate to the other if you open several estimates simultaneously. 
 
Collapse / Expand branches  
 
You can collapse or expand branches to visualize their structure by clicking on the signs + and 
– located at the intersection of the lines which handles the branches and the tasks. These 
symbols are visible in the tree structure at the left of the estimate. 
 
This function does not hide the lines in the B.o.Q. The status Expanded / Collapsed of the 
branches is saved in the file when saving the estimate. 
 
Expand all branches “Organization” menu 
 
Rather than expanding branches one by one, you can call this function to expand all the 
branches in an estimate at once. 

 
To enter data in the B.o.Q. you can type exactly as you would do in a spreadsheet after placing the 
cursor in the “Item”, “Description”, “Unit” and “Quantity” columns. 
 
The sizes of the cells are as follows: 
 

Item 15 characters 
Description 255 characters 
Unit 10 characters 
Quantity 0 to 9’999’999’999.99 

 
You can edit the above cells by double clicking them or by pressing the F2 key.  
 
If you have to add comments in the B.o.Q. you can insert lines under the lines created by Quick 
Devis® Free Edition. To do so, you can use the following functions: 
 

Insert row  “Edition” menu (ctrl + L or shift + F1) 
 
This function inserts a line on top of the line on which the cursor is if no preliminary selection is 
made. If several lines are selected, the function inserts the number of lines appearing in the 
selection on top of the first selected cell. 
It is imperative that the first cell of the selection is on a zone placed between two tasks or 
branches to allow insertion. It is impossible to insert lines before a total or a branch. 
 
Delete row  “Edition” menu (ctrl + D or shift + F2) 
 
This function deletes the line on which the cursor is if no preliminary selection was made. If 
several lines were selected, the function deletes these lines. 
 
The lines to be deleted must be between two tasks or branches; you cannot delete a selection 
across tasks. 
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The standard functions Cut / Copy / Paste are provided to manage data in the columns “Description” 
and “Unit”. 
 

Cut “Edition” menu (ctrl + X) 
 
This function copies and deletes the selected cells. The copy is placed in a clipboard which is 
operative during the current session. The function cannot be cancelled in the B.o.Q. 
 
Copy “Edition” menu (ctrl + C) 
 
This function copies the selected cells. The copy is placed in a clipboard which is operative 
during the current session. 
 
Paste “Edition” menu (ctrl + V) 
 
This function pastes the cells copied using the “Cut” or “Copy” functions. You cannot paste if 
the target has a smaller size than these of the source area. The height of the lines is 
automatically adjusted according to their contents. 
 
Erase  “Edition” menu (Del) 
 
This function erases the contents of the selected cells and readjusts the height of the lines 
automatically. 
 

Note: You can enter data in the column “Item” in any line, even if the line does not match a task row. 
You cannot do so in the columns “Unit” and “Quantity”. 
 
Typing data in lines which do not match tasks in the column “Item” lets you produce apparent 
chapters without having to put sub-totals on them. 
 
Below is an example employing this kind of chapter in which the B.3 chapter is virtual, it does not 
correspond to a real chapter but simply consists of a line which was added under the B.2 task. 
 
Only the chapters B, C and D in our example constitute true chapters generating sub totals. 
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Recommendation: When your bill of quantities is built, it is recommended to launch the “Reindex 
estimate” function. 
 

Reindex estimate   “Tools” menu 
 
This function guarantees the integrity of the estimate by redrawing the B.o.Q starting from the 
structure of the estimate stored on disk. Quick Devis® Free Edition checks the integrity each 
time you print. It is recommended to call this function after each important change in the tree 
structure (copy / paste of tasks or branches, removal of branches, etc.) 
 

The column “Description” of the B.o.Q. supports many formatting functions similar to those usually 
found in spreadsheet programs. 
 

Font name   
 
This function lets you specify the font name of the selected cells. You can choose from the 
drop-down list or type it directly. This function is applicable to the “Description” column only. 
 
Font size  
 
This function lets you specify the font size of the selected cells. You can choose from the drop-
down list or type it directly. This function is applicable to the “Description” column only 

Fictitious 
chapter 
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Colors of the Font   
 
This function lets you define the font colour of the selected cells. It is applicable to the 
“Description” column only. 
 
You have to select a colour or to cancel to continue working after a call to this function. To 
select a colour, click simply on the desired colour, to cancel, press the right button of the 
mouse or click on the basic colour located at the top of the list. 
 
Bold / Italic / Underlined  (ctrl + G, ctrl + I, ctrl + U) 
 
This function lets you change the face of the selected cells. It is applicable to the “Description” 
column only. 
 
Alignment   
 
This function lets you align left, center or right the texts appearing in the selected cells. It is 
applicable to the “Description” column only. 
 
Fonts  “Format” menu 
 
This function lets you define the characteristics of the fonts appearing in the selected cells. It is 
applicable to the “Description” column only. 
 
You can define with this function, the name, size and colour of the font. 
 
Colour markers    
 
This button shows the “colour markers” menu bar.  
 
To use the markers in the B.o.Q. click on the colour of your choice, then click on the first point 
where you wish to place the mark and, without releasing the left button of the mouse, drag the 
cursor up to the second point and release the button. 
 
To remove a colour mark, click on the white marker with a red cross and simply click on the 
mark to be removed. 
 

Quick Devis® Free Edition has formatting functions which apply to the entire B.o.Q. They let you 
adjust the height of the line spaces, assign specific fonts to the tasks, totals and sub-totals or adjust 
the zoom factor. 

 
Adjust spacing  ”Format” menu 
 
This function lets you adjust the height of the lines which are between the tasks. 
The lines in the “Description” column adjust automatically to allow the visualization of their 
entire text. 
 
Tasks fonts “Format” menu 
 
This function lets you define the fonts for various kinds of tasks appearing in an estimate: 
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• Simple tasks 
• Sub-totals 
• Grand total 

 

 
 
Note that the font colour of the simple tasks is always black except for the column 
“Description” where you can set the colour of each cell. The font of the other kinds of tasks can 
be coloured as you wish. 
 
Alignment of tasks “Format” menu 
 
This function lets you set the alignment of sub-totals and grand total. 
 
Define fonts  “Format” menu 
 
This function lets you define specific fonts for every overlapping level in an estimate (chapter, 
sub-chapter, etc.) 
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To specify each font name, click successively the frames from top to bottom, corresponding to 
levels 0 to 7 and select the desired names, sizes, colours, faces and alignments using the 
tools at the bottom of the window. Then press the “Apply” button to accept. 
 
Applying fonts to a B.o.Q. does not assign automatically these fonts when you create new 
tasks; if you create a task after having applied fonts, it will always inherit the format of the task 
from which it was created and not the format specified by the “Define fonts” function. It could 
thus be necessary to call the function again after structuring the B.o.Q. 
 
Column width  “Format” menu 
 
This function lets you adjust the width of the selected columns. You can specify a value or use 
the standard value by checking the appropriate box. You can change this standard value by 
clicking the “Change default” button. 
 
Zoom  “Format” menu 
 
This function lets you define the zoom factor used to display the B.o.Q. The values can be 
from 50% to 150% of the standard view. 
 

If requested, you can search for a text in the B.o.Q: 
 
Search  “Edition” menu 
 
Use this function to search a text in the entire bill of quantities sheet. 
You can select the search order by initially scanning the lines or initially the columns. You can 
also specify if the searched cell must contain only the specified text. Lastly, you can specify if 
the case of the characters must be respected. 
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Printing functions, specific to the B.o.Q. are available: 
 
Print  “File” menu 
 
This function lets you print the B.o.Q in various frames: 
 

 
 
The first option will print the print area defined using the “Set print area” function in accordance 
with the page attributes defined with the “Page setup” function. 
 
The three other options let you print the complete B.o.Q. with three different standard contents. 
The page attributes are automatically adapted for these three editions so that the page is filled 
out best. 
 
The “Preview” button lets you visualize the edition before printing it.  
 
The “Page setup” button lets you change the settings of the page; this button is active only for 
the first option. 
 
Show gridlines  “Window” menu 
  
Use this function to display grid lines in the bill of quantities. 
 
Freeze / Unfreeze panes “Window” menu 
  
If you freeze the panes, the two first lines of the B.o.Q. will scroll with the document. If you do 
not freeze them, those lines will stay at the top of the document. 
 

It can be useful to evaluate the costs of a chapter or a specific task sorting items. For this purpose, 
Quick Devis® Free Edition comprises an adapted tool: 

 
Summary  “Calculation” menu (F12) 
 
This function lets you “weight” a task, a branch or an entire estimate. The displayed 
breakdown always refers to the task or the branch on which the cursor is when the function is 
called. 
 
If you wish such a breakdown of the entire estimate, place the cursor on its first line or on its 
grand total line. 
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You can print the displayed breakdown by clicking the “Print” button or export it to Microsoft 
Excel by clicking the “Send to Ms Excel” button. 
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The detailed view 
 
The detailed view lets you enter detail for each task of a bill of quantities. This view is similar to a 
spreadsheet.  
 
To reach the “detailed view”, you can click on the “Detailed view” tab at the bottom of the main 
window, double click on a task in the B.o.Q. (yellow cells) or press the F4 key. The last method is the 
most convenient because the same key lets you enter the detail and return to the task within the 
B.o.Q. (by pressing the F4 key again). 
 
The detailed view displays as follows: 
 

 
 
As in the B.o.Q. all the tasks appear in a tree structure placed at the left of the tables representing the 
detail of each task. 
 
The presentation of the detailed view can be easily modified in order to adapt it to your own needs. 
To change the presentation of the detailed view, call the function “Setting of detailed view or 
nomenclatures” described in the chapter Common functions. 
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To scroll the detailed view, you can use the arrow keys or use the right scroll bar which scrolls the 
rows inside a task. To scroll within the entire estimate, directly click the task to be reached in the tree 
structure located at the left side of the view or use the little arrows below the right scroll bar. You can 
extend the detailed view by clearing the box below these arrows. 
 
To enter a new row in the detailed view, you can manually type the field contents as you would do in 
a spreadsheet. To edit the fields, double click on them or press the F2 key. 
 
Other functions let you insert or modify data within the detailed view. They are described below.  
 
To use these functions, you have to know how to select rows in the detailed view: the selections can 
be made with the mouse by keeping the left button pressed while moving the mouse across the 
selection or, more efficiently, by pressing the <SHIFT> key while the cursor is moved. To select a 
single line, press the <SHIFT> key first and then, the <Right arrow > key or the <Left arrow> key. 
 
If you wish to make an operation on all the rows of the detailed view, you can use the function: 
 

Select all “Edition” menu 
 
This function selects all the rows of the current task. 

 
The selection methods are similar to that used in spreadsheets. The main difference is that most of 
the functions relate to whole rows and not to cells. 
 

Cut row  “Edition” menu (ctrl + X) 
 
This function copies then removes whole lines which should be selected first. The copy is 
placed in a temporary clipboard on the disc and is available for all future sessions of Quick 
Devis® Free Edition. 
 
Copy row   “Edition” menu (ctrl + C) 
 
This function copies the selected rows. The copy is placed in a temporary clipboard on the disc 
and is available for all future sessions of Quick Devis® Free Edition. 
 
Paste row  “Edition” menu (ctrl + V) 
 
This function inserts and pastes rows copied or cut using the “Cut row” or “Copy row” 
functions. 
 
Copy cell  “Edition” menu (ctrl + M) 
 
This function copies the contents of the cell on which the cursor is. Only one cell must be 
selected. The copy is preserved only during the current session. 
 
Paste cell  “Edition” menu (ctrl + Q) 
 
This function pastes the contents of a cell copied using the “Copy cell” function in the cell 
where the cursor is. The column which receives the data must be compatible with that in which 
the data was copied (text or value). 
 
Insert line  “Edition” menu (ctrl + down) 
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This function inserts as many rows as selected before the call. It inserts one row below the row 
on which the cursor is if no line is selected. 
 
Insert before  “Edition” menu (ctrl + L) 
 
If no line is selected when calling this function, a window will prompt you to enter the number 
of rows to be inserted. The number of rows specified is then inserted before the cursor 
position. If rows are selected when calling the function, a number of rows equivalent to the 
number of selected rows is inserted before the cursor position. 
 
Delete rows  “Edition” menu (ctrl + D) 
 
If no row is selected when calling the function, a window will prompt you to enter the number of 
rows to be deleted. The number of rows specified is then deleted starting with the row on 
which the cursor is. If lines are selected when calling the function, these lines are deleted. 
 
Glossary  “Edition” menu (F11) 
 
The glossary is somewhat like a huge clipboard with multiple memories which will be 
convenient if you have to copy / paste data repetitively and frequently. 
 
The operation of the glossary is described in the chapter The glossary.  
 
Replace by the article whose reference is mentioned  “Data” menu (Ctrl + W) 
 
This function automatically inserts one or more articles coming from a database after typing 
only the mnemonic code of the database followed by the reference or the description of the 
article. 
 
The code can be typed in the fields “Description”, “Reference”, “Family”, “Manufacturer” or 
“User field”. The mnemonic code which identifies the database must comprise three characters 
and can be defined using the menu “Set up searching prefixes”. For further information on 
defining prefixes, read the chapter Setting prefixes in this manual. 
 
To search for a reference, the syntax is as follows (example): 
 
MGE20200 (inserts the article from the Merlin Gerin database having the reference “20200”) 
If the reference does not exist in the database, the database will open and show the nearest 
reference. If it does exist, the article is inserted without opening the database. 
 
MGE C60N 2x4A (inserts the article from the Merlin Gerin database having the description 
“C60N 2x4A”) 
If the description does not exist in the database, the database will open and show the nearest 
description. If it does exist, the article is inserted without opening the database. 
 
The presence of a space between the mnemonic code and the data will determine if the 
search should be done using the reference or the description. If there is no space, a reference 
is searched, if there is one, a description is searched. This selection does not depend on the 
field in which the code was typed but only on the presence of the space. 
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You can type several codes on several consecutive rows and replace them by articles in only 
one operation. To do so, just select the lines codified before calling the function. 

 
Copy down “Edition” menu (ctrl + B) 
 
This function lets you copy the contents of the cell on which the cursor is the number of times 
specified to the cells which are immediately below it. If you specify a number higher than the 
number of lines remaining in the task, the copy will not be propagated beyond the last line of 
the current task. All the editing columns can accept this function. 

 
Copy first row of task  “Edition” menu (ctrl + Y) 
 
This function lets you copy the first row of the current task in the B.o.Q. to the row on which the 
cursor is. This is to avoid recopying manually data appearing in the B.o.Q. when the detailed 
task contains only one line. 
 
The function also copies the quantity and the unit appearing in the B.o.Q. 
 
Display all rows from B.o.Q.  “Edition” menu 
 
This function displays in the “detailed view” all the text lines appearing in the B.o.Q. including 
those of the chapters. If the button is released, only the lines referring to the tasks are shown. 

 
The “detailed view” also offers functions of data retrieval, in the estimates and in the databases: 
 

Find current row in its original database  “Edition” menu (Ctrl + F3) 
 
This function, when called with the cursor placed on an article which comes from a database, 
automatically opens the database and points out the article in the database. 
This will be particularly useful to quickly replace an article by another to change its dimensions 
or its weight for example. 
 
Search  “Edition” menu 
 
This function lets you search a text in one of the five key fields of the detailed view 
(“Description”, “Reference”, “Family”, “Manufacturer” and “User Field”). 
 
Search is always made starting from the cursor position, from left to right then downwards. If 
no occurrence is found, it goes automatically to the top of the estimate (or the task according 
to the appropriate check box) and stops on the row where the cursor is. 
 
You can specify if the required cell must contain only the specified text and if the case of the 
characters must be respected. 
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If the first search gave a result, you just have to press the F3 key to find the next occurrence. 
So you do not have to call the function again. 
 

Some formatting functions are available in the detailed view: 
 

Bold / Italic / Underlined  (ctrl + G, ctrl + I, ctrl + U) 
 
These functions let you change the current cell’s typeface. You can select bold, italic or 
underline as required for the texts appearing in the “Description” column. The other columns’ 
typeface cannot be changed. These functions only relate to whole cells. 
 
Colour markers    
 
This button displays the colour markers bar.  
 
To use the markers in the detailed view, select the lines to be marked and click the desired 
colour. To remove a mark, proceed in the same way and simply click on the white marker with 
a red cross. 
 
Show gridlines  “Window” menu 
  
This function lets you display the grid lines in the detailed view. 
 

The last operation ran in the detailed view can be cancelled, even if this operation relates to the 
entire estimate. 
 

Cancel  “Edition” menu (ctrl + Z) 
 
Use this function to cancel the last operation ran in the detailed view. Any operation can be 
cancelled. If you leave the detailed view to reach another view, the ability to cancel is 
removed. Displaying a database is not considered as reaching another view; the insertion of 
articles can thus be cancelled. 
 

You can append data to the databases directly from the detailed view using the following functions: 
 

Record article in database “Data” menu (ctrl + E) 
 
This function records the selected articles in the specified database. To be recorded in an 
existing private database, the articles must comprise at least one of the following key fields 
(“Description”, “Reference”, “Family”, “Manufacturer” or “User field”). If you wish to record an 
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article in an “Internet” database, the field “Reference” must be specified because this kind of 
database identifies its articles using the “Reference” field only. 
 
If an article already exists in the database, you will be prompted to state if you wish to replace 
it by the selected article. 
 
In a private database, an article is regarded as identical to another if and only if the five key 
fields (“Description”, “Reference”, “Family”, “Manufacturer” or “User field”) match. The case of 
characters is not considered; the uppercase letters are thus equivalent to the lowercase ones. 
 
In an Internet database, an article is regarded as identical to another if its “Reference” 
matches. The other fields are ignored in the comparison. 
 
Note: It is not recommended that you record articles in the Internet databases because, when 
they are updated, the added articles will be removed. You can, on the other hand, add, for 
example; work times or kinds of workforce to Internet databases. These data will be correctly 
preserved when updating the database from the Web. 
 
Update article in database “Data” menu (ctrl + T) 
 
This function lets you update an article in a database with the data that are on the selected 
lines. The lines must come from databases. 
This function will be useful to enrich the databases by adding additional data, e.g. workforce 
times or kinds of workforce.  
 
If you modify, in the detailed view, the field “Reference” of an article which come from an 
Internet database, you will not be able to update it again if the reference specified does not 
exist in the original database because Internet databases only identifies their articles according 
to the “Reference” field. 
 
For the private databases (the ones you have created), if you make changes in any key field 
(“Description”, “Reference”, “Family”, “Manufacturer” or “User field”) in the detailed view, the 
article will not be recognized when trying to update and an error will be generated. In order to 
allow updates in a private database, the five key fields must be identical. 
 

The actualization of the detailed rows from the databases is also possible using the function: 
 

Update rows “Data” menu (ctrl + J) 
 
This function lets you update the selected rows in the “detailed view” starting from their original 
databases. If the databases were updated, the data present in the detailed view will be 
immediately updated when calling the function. 
 
By default, the function updates the “price per unit” and the “rebate” but you can also update 
the “time per unit” and the “kind of workforce” by checking the appropriate boxes.  
 
In order to update the selected rows, the articles must be recognized by their databases. For 
this purpose, Quick Devis® Free Edition uses the “Database source” field of the detailed view 
which contains the path and the database file name of each article. 
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If an article comes from an Internet database, Quick Devis® Free Edition seeks for the 
reference of the article in the database; if it finds it, the row is updated. The other key fields 
(“Description”, “Manufacturer”, “Family”, “User field”) are then ignored and are replaced by 
these appearing in the database. 
 
If the article comes from a private database, the five key fields must be identical in the 
“detailed view” and in the “database” for the articles to be recognized. These fields are: 
“Description”, “Reference”, “Manufacturer”, “Family” and “User field”. The case of the 
characters is ignored for the comparison. 
If you have made changes to a field (the “description” field in the database for example), you 
can specify that this field should not be taken into account in the comparison by checking the 
appropriate box. Another box then lets you specify if the field thus ignored in the comparison 
must be reported on the selected rows. 
 
Simply click on the “Update” button to start actualizing the selected rows. The status of the 
check boxes is automatically preserved for the next call until you leave Quick Devis® Free 
Edition. 

 
You can insert in the detailed view some data coming from external tools (CAD software, etc.) 
For this purpose, you can call the function: 
 

Insert a frame of articles from Excel  “Data” menu 
 

This function lets you import data in Microsoft Excel™ format or CSV format (delimited text 
files) directly in the detailed view. You can, for example, import a frame containing only 
references and quantities and transform these data into fully developed articles using the 
“Update rows” function described above. 
 
When calling the function, you’ll have to select a Microsoft Excel™ file (.XLS) or a delimited 
text file (.CSV) 
 
If an error message appears while opening a Microsoft Excel™ file, it is probable that elements 
like macros or charts appear in the file. These elements are not supported by the function. In 
such a case, carry out a “copy/paste values” under Microsoft Excel™ in a new workbook and 
try again. 
 
Quick Devis® Free Edition supports three different separators (vertical separator, semicolon or 
tabulation). It detects automatically the separator used. 
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When the content of the file is displayed, you must provide the columns’ names. Locate the 
cursor on the header of each column to be defined (line 1) and click on the button “Change the 
column’s name” or double click on the cell. Then, select then the name of the corresponding 
field and click the ‘Ok’ button. 
 
To remove a column’s name so that it is not imported in the detailed view, locate the cursor on 
the header and simply press the <DEL> key. 
 
When the columns’ headers are set, select the lines to be imported and click on the button 
“Import in current detailed view”. 
 
Note: the positions of the columns are preserved so that you do not have to redefine them 
before each new importation. 

 
To speed up insertion of articles from databases, without having to open the bases, you can use the 
function: 

 
Set up searching prefixes  “Data” menu 
 
This function lets you associate prefixes composed of 3 letters to your databases to allow 
insertion directly in the detailed view without having to open the databases. Then, you will just 
have to type the prefix followed by the reference or the prefix followed by a space and the 
description to automatically insert the article in the detailed view. This can be done using the 
function “Replace by the article whose reference is mentioned” (“Data” menu). 
 
To set up searching prefixes, read the chapter Setting prefixes in this manual. 
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The nomenclatures view 
 
You can use the nomenclatures view to reclassify the estimate according to various criteria in order 
to prepare order lists or to display the important amounts of material and workforce to compare them 
with various ratios in order to “weigh” the estimate.  
 
To reach the nomenclatures view, you can click on the “Nomenclatures” tab located at the bottom of 
the main window, or use the contextual menu by pressing the right mouse button. 
 
The nomenclatures view displays as follows: 
 

 
 
The displayed data can be printed or exported to Microsoft Excel by clicking the appropriate buttons. 
 
Quick Devis® Free Edition does not allow changes in the nomenclatures view. Consider using Quick 
Devis® Enterprise Edition if you wish to make such changes. 
 
Various functions, specific to the nomenclatures, are available in the menu bar: 

 
Select sorting key  
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Click the drop-down list in the menu bar from which you can select any of the following for your 
sort criteria: 
 

• Manufacturer 
• Families 
• Reference 
• Description 
• User field 
• Kinds of workforce 

 
These various keys let you group articles which have identical fields and provide sub-totals on 
them. 
 
Display only significant rows  “Edition” menu 
 
When this function is set, only the rows having a quantity in the detailed view, a quantity in the 
B.o.Q. and an amount of material or workforce are displayed. If not set, all the rows are 
displayed in the nomenclatures, including the comment rows. 
 
If the button is pressed and you do not see, in the nomenclatures some significant rows, it is 
probably because the task which “carries” the rows in the B.o.Q. has no quantity or because 
the branch to which this task belongs has no quantity. 
 
Find current row in its original database  “Data” menu (Ctrl + F3) 
 
When you call this function with the cursor located on an article which comes from a database, 
it automatically opens the original database and points out the article. 
 
Search “Edition” menu 
 
This function lets you search for a text in all the visible rows in the nomenclatures. 
You can select the search order by initially scanning the rows or initially the columns. You can 
also specify if the searched cell must contain only the specified text. Lastly, you can specify if 
the case of the characters must be respected. 
 

If you wish to modify the appearance of the nomenclature view, call the “Settings of detailed view or 
nomenclatures” function in the “Options” menu. Its operation is described in the chapter Common 
functions. 
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The Overhead sheet 
 
The “Overhead sheet” or “Environment” was designed to calculate the coefficients of sale and to 
determine the resulting margin. Quick Devis® Free Edition lets you use up to 4 different coefficients 
within the same estimate. These coefficients are distributed as follows: 
 

• One on each kind of workforce 
• One on material 

 
To evaluate reliable data, the overhead sheet may need to be refreshed. In such a case, the words 
“Refresh requested” will blink at the left top of the sheet. Just click on these words or launch a 
“recalculation” to obtain the current data. 

The “Overhead costs” sheet 
 

The overhead expenses worksheet proposed in Quick Devis® Free Edition lets you automatically 
determine the resulting margin according to the entered coefficients and possible overhead fixed 
costs. 
 
If your requirements in terms of price analysis or in calculation of coefficients are more advanced, 
consider purchasing Quick Devis® Enterprise Edition which lets you directly integrate your own 
calculations, however complex, using the Microsoft Excel format without any to their complexity. 
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The cells appearing in white in this sheet are automatically computed by Quick Devis® Free Edition. 
The data concerning the customer comes from the “estimate declaration”. The kinds of workforce and 
associated rates come from the “Workforce” sheet in which you must enter inform the appropriate 
information. 
 
The cells appearing in yellow may be entered by the user. You can type the coefficients of sale in the 
4 appropriate boxes, and the overhead costs in the table located at the bottom of the document. The 
yellow area under the customer’s data is available for any text, number or formula that you may need 
to enter. (Use the Microsoft Excel format) 
 
According to these data, Quick Devis® Free Edition determines automatically the cost of the 
operation by simply totalling the costs of workforce, costs of material and overhead costs. It 
compares the result with the selling price obtained by multiplying the coefficients by the material and 
workforce amounts. Then, it expresses the expected margin as a percentage of the selling price 
using the formula [selling price - costs] / selling price. 
 
The typed coefficients must, at least, cover the overhead costs. If not, the resulting margin will be 
lower than zero. 
 
The “Workforce” sheet  
 
The “Workforce” sheet lets you define the workforce resources which could be used in the “detailed 
view”. You can define up to 3 workforce resources in the unit and rate of your choice. If your needs 
are greater, consider using Quick Devis® Enterprise Edition which let you define up to 99 workforce 
kinds and 99 material kinds. 
 

 
 
If you express your resources in a unit different from the hour, minute or second, you will have to 
specify how many hours constitute your unit because Quick Devis® Free Edition calculates its 
workforce resources on an hourly basis. 
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If you do not provide the currency in which the resource must be calculated, Quick Devis® Free 
Edition will use the reference currency automatically. 

The “Families” sheet 
 
The “Families” sheet displays all the articles in the estimate according to the “Family” field used in the 
detailed view and provide for each family a total for the material and the associated workforce cost. 
 

 
 

You can use this sheet to categorize the material or the workforce resources. The number of families 
in an estimate is not limited but Quick Devis® Free Edition can display in the “Family” sheet only the 
first 250 families appearing in the estimate. The other families, if any, will appear at the bottom of the 
sheet on the line “Families not qualified”. 
 
The “Currencies” sheet   
 
Quick Devis® Free Edition lets you define up to 99 currencies by indicating their parity with the 
currency chosen to be the reference currency. If you display the “Currency” column in the detailed 
view, you will be able to specify on each line the currency you want to use. Without specification, the 
reference currency will be used. 
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To append a new currency, type its 3 letters code and its rate expressed in the reference currency or 
the rate of the reference currency expressed in the new currency. 
 
If you wish to print your estimate in a currency different from the reference one, just change the 
reference currency by selecting it in the list located on the top right next to the word “Reference”. 
 
Important: When you change the reference currency of an estimate, ensure that all the rows with 
material in the estimate have an assigned currency. If not, Quick Devis® Free Edition will assign to 
these rows without currency, the new reference currency causing a difference in price between the 
initial estimate and the estimate expressed in the new reference currency. 
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The Arrange view 
 
Quick Devis® Free Edition can display the estimate in “Arrange” mode which lets you easily move 
tasks within an estimate in order to add chapters or to change the general organization of a bill of 
quantities. 
 
To reach the “Arrange” mode, click on the appropriate tab at the bottom of the main window or use 
the contextual menu clicking the right mouse button. 
 

 
 

With this mode, you can move entire tasks (with their contents) or even chapters by keeping pressed 
the left mouse button while you move items across the tree view. To terminate the move, just release 
the button. 
 
When you release the button after having placed the cursor on the host task, Quick Devis® Free 
Edition will prompt you to specify if the task or the branch to be moved must come immediately under 
the selected task (same level) or if the moved data constitute a child task (or branch) of the selected 
task (next level). In the last case, the contents (detailed view) of the host task will be definitely 
deleted because the task will become a branch. A branch cannot contain detailed rows. 
 
If you make a mistake while reorganizing, just do not validate your changes. You will be prompted to 
do so you when you will leave the “Arrange” view going to another view. If you answer “Yes” to the 
validation request, Quick Devis® Free Edition will automatically reorganize the estimate according to 
your new classification.
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The Options 
 
Various options let you determine the behaviour of Quick Devis® Free Edition or the behaviour of a 
particular estimate. The “Calculations”, “Display settings”, “Rounding” and “Tree view” tabs apply to 
the estimate from which the options were called. Changes made in the “Settings” tab are stored in the 
user’s profile. So, they stay operative for any future sessions of Quick Devis® Free Edition. 
 

Calculations “Options” menu 
 

This tab lets you specify if the “Value Added Taxes” and the “All Taxes Included” amounts 
must appear at the bottom of the B.o.Q. so check the appropriate box. The applicable V.A.T. 
rate must also be provided. 
 

 
 
These options apply only to the estimate from which they were called. If you want them to be 
applied to all of your new estimates, set them in a model estimate. 
 
Display Settings “Options” menu 

 
This tab lets you define the colours used in the B.o.Q. view. You can set the colour of the cells 
which match tasks (those which handle detailed rows in the detailed view) and the background 
colour of the B.o.Q. header. 
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You can restore the default colours by clicking the appropriate button. Then, your system’s 
colours will apply. 

 
These options apply only to the estimate they were called from. With the report generator, you 
can define other headings with other colours. 
 
If you want the “Display settings” to be applied to all your new estimates, set them in a model 
estimate. 
 
Rounding settings “Options” menu 

 
This tab lets you define the rounding level which will be used for the selling prices in the 
detailed view and in the B.o.Q. You can also define the rounding level of the quantities in the 
B.o.Q. 

 
It is recommended to use the lowest available level as shown in the example below. Indeed, 
the use of a high rounding level can have important effect on the final price because it causes 
the rounding of the selling prices of each row in the detailed view. It is then, the sum of each 
rounded row which is reported in the bill of quantities (and not the rounding of the total of the 
non rounded rows). 
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You can choose a specific number of decimals to display selling prices in the B.o.Q. However, 
only some values will be proposed according to the rounding level selected for the quantities 
and the selling prices of the detailed view. 
 
These restrictions are forced in order to guarantee that a breakdown presented with the rows 
of the detailed view in the reports generator will always post correct calculations. Meaning the 
posted quantities multiplied by the posted unit prices will give exactly the total prices shown on 
the rows. In the same way, the sum of the total amounts rounded displayed on each row will 
give exactly the total amounts appearing at the bottom of the chapters. 
 
Important: If you modify the rounding level of the quantities of an existing estimate going to a 
higher level, Quick Devis® Free Edition may change some quantities appearing in the detailed 
view and you will not be able to retrieve them. In such a case, it is recommended that you save 
your estimate first to keep track of the original quantities. 
 
The rounding options apply only to the estimate from which they are called. If you want them to 
be applied to all your new estimates, set them in a model estimate. 

 
Display tree view “Options” menu 

 
This tab lets you define the appearance of the tree structure located at the left of the main 
window and to define the numbering model which will be used as default in your B.o.Q. when 
you will create tasks and sub-tasks. 
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Quick Devis® Free Edition lets you enter any quantity in the branches of an estimate 
(chapters) in order to multiply entire branches. This capability can however generate typing 
errors for people accustomed to regard branches as simple chapters without quantity. 
If you wish to prohibit the use of quantities in the branches, check the suitable box and Quick 
Devis® Free Edition will replace the unspecified or wrong quantities by the value 1 in all the 
branches of the estimate. 
 
If you wish your estimate to be numbered according to logic; 1 for the chapters, 1.1 for sub-
chapters, 1.1.1 for sub-sub-chapters, etc enter 1 as item of a sub task and .1 as sub item.  
If you would rather have an alphanumeric classification for example, enter A as item of a sub 
task and A.1 or A.A as sub item. 
 
These changes in the logic of classification will affect only the tasks created subsequently to 
the changes. If you wish to renumber a whole estimate according to your new logic, call the 
“Renumber all task” in the “Organization” menu. 
 
The “display tree view” options apply to the estimate from which they were called. If you want 
them to be applied to all your new estimates, set them in a model. 

 
Settings “Options” menu 

 
This tab lets you define the proposed default directories for access to the estimates and to the 
models of automated frames. It also lets you define the directory in which the databases will be 
stored. 

 
To set directories, click the “Set up” buttons and select the new paths. You can also delete the 
contents of the fields so the last directory used will be proposed. 
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You must indicate a directory for the databases. If you do not do it, it will be impossible to use 
them. This directory can also be specified using the “Path” button of the articles’ window. 
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Working with public databases 
 
In some countries, you can profit from on line manufacturers’ tariff by subscribing to this service from 
a provider. To get the list of available providers and their conditions of subscription, click the “Web 
U.R.Ls” function in the “Data” menu. 

 
Web addresses  “Data” menu 
 
This function lets you select a database provider and subscribe to a contract which will let you 
download and keep up to date your tariff databases. You must be connected to the Internet 
before calling this function. 
 
The providers appearing in the list are approved by our services and guarantee compatibility 
with the software. To select a provider, simply call the function and make your choice visiting 
the listed Web sites or contacting directly the providers. 
 
When you subscribe, the provider will authorize your Quick Devis® Free Edition identifier on 
his web site and you will be able to download the databases calling “Update databases from 
the web” function. The databases thus downloaded will work only on the computer used to 
subscribe. 
 
Important: Each provider can propose different panels of databases whose references can be 
coded differently; consequently, if you plan to change your provider after having used the 
databases, it is recommended that you create a new directory to store the new provider’s 
databases or to backup your previous databases. 
Indeed, if you try to update databases resulting from a provider with those of another, some 
articles may be destroyed if their references do not exist in the new provider’s database. If you 
added workforce times or workforce kinds in these articles their data will then be lost. 
 
If you wish to test the databases of a provider without having to subscribe, you can select the 
provider in the list and directly call the “Update databases from the web” function. You will then 
be allowed to import incomplete databases comprising only one article out of ten. 
 
Update databases from the Web   “Data” menu 
 
This function lets you download or update databases from a public Web site. Before calling 
this function, you must select a provider using the "Web addresses” function. 
 
Connection to the remote site is done automatically and, after a short period of time, the list of 
the available databases appears in the left side list. The right side list displays all Internet 
databases that already are in your local databases directory. 
 
Note: the communication uses HTTP protocol and your Microsoft Internet Explorer settings. If 
you encounter communication problems, select another databases provider or make sure you 
can navigate on the selected provider’s site using Microsoft Internet Explorer. 
 
Your provider may, if required propose several databases directories. Click the drop-down list 
located under the left side list to display these directories and their contents. 
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Just for the first time, you may have to set a path for the data storage (except if you already did 
it using the function “Configure an estimate”). To set a path, simply click the button “set up the 
local path for databases” (or the “Path” button from the databases list). 
 
Then, select the provider’s databases you are interested in on the left side list (you can keep 
the SHIFT key pressed to select several databases at once) and click “Append selection” 
button. The selected databases are then moved to the right side list, being available for 
downloading. 
 
You can also add all the available databases at once clicking the “Append all” button. 
You can do similar operations from the right side list using the “Remove selection” or “Remove 
all” buttons. 
 
If you already made a first remote loading, the list of the downloaded databases which are on 
your computer appears in the right side list. In this case, if you simply wish to update these 
databases, click the “Add all databases which may be updated” button. Quick Devis® Free 
Edition will only download the databases which require an update among the databases which 
are on your computer. 
 
The databases requiring an update are tagged in the right side list with an orange triangle. 
Database which are on the remote web site but does not exist on your computer are tagged 
with a “New” symbol in the left side list. 
 
After moving databases to be downloaded from the left side list to the right side list using the 
functions described above, you will just have to click the “Download databases” button “ to 
launch the following operations: 
 

• Downloading of the selected databases 
• Conversion to Quick Devis® Free Edition format 
• Data mixing with your databases (databases which were on your computer) if they do 

exist in order to keep your additional data (work times, kinds of workforce…) 
 
When the process terminates, Quick Devis® Free Edition displays a download report. If a 
database was not correctly downloaded, it appears in the report and you just have to download 
it again. 
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When all databases are downloaded, you must download the empty rebates tables (which are 
tables containing rebates codes of the various manufacturers). To download these tables, click 
the “Download rebates” button. This operation can be done before or after the downloading of 
the databases. 
 
Downloading the rebates tables allows the rebate figures already entered on your computer to 
be preserved. However, in order to avoid preserving the rebates of a previous tariff and to 
apply them to a new tariff, this renewal of the rebates requires a voluntary action: You will have 
to call the “Rebates editor” function and to click on the “Transfer” button. 
 
Finally close the application clicking the “Close the session” button in order to return to Quick 
Devis® Free Edition. 
 
Under Quick Devis® Free Edition, you then have access to all of the tariffs downloaded calling 
the “Access databases” function. If no database appears after the downloading, check the path 
clicking the “Path” button of the “Access databases” function and make sure it matches the 
path used while downloading. 
 
Later, when you wish to update your databases, just call the function “Update databases from 
the web” and click the “Add all databases which may be updated” button. Proceeding this way, 
Quick Devis® Free Edition will download only the databases which really require an update 
and will ensure a mixing with your own data so as to preserve the data you might have added 
such as work times or kinds of workforce. At the end of the update, you will have to download 
the rebates tables again clicking the “Download rebates” button; your rebates rates will then be 
preserved and mixed with the new data. 
 



Quick Devis® Free Edition                                                                                                               User’s Manual 
 

Quick Devis® Free Edition © IAES (1991-2006)                                                                                   Page 64/105 

Quick Devis® Free Edition will preserve the old databases in the same directory as the new 
ones. To remove the old databases, click the “Delete” button of the “Access databases” 
function. You will be prompted to specify if you want to delete only the selected database or all 
the obsolete databases remaining in the directory. 
 
Answer the above question by clicking “Yes”. Quick Devis® Free Edition will select all the 
obsolete databases and will prompt you to confirm the destruction by clicking again the 
“Delete” button.  
 
Note: The providers usually update their databases on a monthly basis. It is thus suggested 
that you call the “Update databases from the web” once a month. 
 
If the update of a database fails while returning a message such as “Damaged database”, it 
might be because the database on your disc is damaged and its updating from the remote 
database is not possible. In such a case, before contacting the database provider, try to repair 
the database using the “Repair an estimate or a database” function in the “Tools” menu. If the 
problem is not solved, remove the database from your disc before downloading the new 
database. 
 
Rebates editor  “Data” menu 
 
The databases supplied by the public providers do not comtain rebates but only tariffs. In order 
to specify your own rebates, the providers supply empty rebate tables which are coded to 
match the articles and manufacturers they provide. 
 
These rebate tables can be downloaded clicking the “Download rebates” button of the “Update 
databases from the Web” function. 
 
To specify the rebates you wish to use for each manufacturer and each family of articles, call 
the “Rebates editor” function and enter the rebates values in the “Current rebate” column for 
each manufacturer you will use. 

 
The list of the manufacturers, located on top left of the window, displays 3 different symbols 
according to the databases’ status: an “earth” indicates that the database which is on your disc 
conforms to its corresponding rebates table (in terms of date). A question mark (?) indicates 
that the database, or its rebates’ table do not conform and thus require an update. Lastly, a red 
cross on the “earth” indicates that the database exists on the remote web site but not on your 
computer. 
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To enter the rebates, click on each manufacturer you may need on the top list and type the 
rebates in the bottom list. When you will click on another manufacturer, you will be prompted to 
record or cancel your changes. 
 
On the top list, symbols indicate if the rebates table matches with the database located on the 
disc. Indeed, in order to avoid rebates/price association errors, Quick Devis® Free Edition 
checks that the rebates table matches its tariff. If not, a warning message is posted when you 
open the database. 
 
If you see error symbols in the list, click on them to know more about the error. These errors 
are displayed within the top frame at the right of the window. 
 
When you update your rebates tables through the “Download rebates” function, the data of the 
“Current rebate” column are automatically copied to the “Previous rebate” column for all the 
manufacturers whose tariffs were updated. This requires you to renew the old rebates or to 
enter new ones so as to avoid the use of rebates which would not correspond anymore to the 
new tariff of the manufacturer. 
 
If you want to renew all your rebates, for all the manufacturers at once, click the “Transfer” 
button. 
 
If you want to renew the rebates for one or more specific manufacturer, display them by 
clicking them in the top list, make the appropriate selections and use the “Copy” and “Paste” 
buttons to copy data from the “Previous rebate” column to the “Current column”. 
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Warning: If, between 2 database upgrades you do not take care of your rebates by transferring 
them, you will definitely loose you rebates because, for each effective tariffs upgrade, Quick 
Devis® Free Edition moves data from the “Current rebate” column to the “Previous rebate” 
column. Note that you can always recover your rebates by renaming the “Remises.old” file 
(see below). 

 
Most of the manufacturers list a line of products behind each rebate code. To display these 
products, click the “See products” button. To display only the rebate codes, click the button 
again. 
 
You can print the rebates table of the displayed manufacturer by clicking the “Print” button. 
 
Technical tips: the rebate tables are stored in a Microsoft Access format in a file located in the 
database directory to which they apply. This file is named “Remises.rem”. It is backuped in a 
file named “Remises.old” when an update is made using the “Download rebates” function. 
Thus, use these files if you wish to recover past rebates or backup your rebate tables. 
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The Articles Manager 
 
The Articles Manager was designed to manage the contents of the databases and to enable editing 
and inserting their articles in the estimates. 
 
To reach it, click on the button . The list of the available databases appears. 
 

 
 
Quick Devis® Free Edition supports two kinds of databases: the Internet databases which are tagged 
with the icon , (they include a date) and the private databases which are tagged with the icon . 
The window can be extended or reduced vertically in order to display more or less databases; to do 
so, select the bottom border of the window and stretch it. 
 
You can create new databases by clicking the “New” button. This creates a database named “New 
Base”. To change this name, click delicately on the name of the base created, enter the new name 
and click on a white area of the window to accept it, as you would do in the Windows explorer. 
 
Internet databases cannot be created directly. To get Internet bases, select a provider and download 
its databases. Read the chapter Working with public databases in this manual for further information. 
 
To open a database in the articles manager, place the cursor on the database name and double click 
on it or click the “Open” button. Below is the window of the articles manager. 
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The view shown is the complete view, in “Read” mode.  
 

Searching functions 
 
To search for an article, simply type the first few characters of the article in the text box text which is 
next to the “Description” button. After each entry of a new character the cursor goes to the nearest 
article. 
 
If you have to search for articles in other fields (such as the reference field for example), click on the 
heading of the chosen column to cause an immediate reclassification of the database. You can also 
change the sorting order by clicking the “Description” button. 
 
Another searching method consists in using the tree structure at the left of the window. In the Internet 
databases, this structure relates to the “User field” sorting key. For private databases, you can 
specify which sorting field you want to use when you create the tree structure (you will find more 
information about this below in this chapter). 
 
When you use the left mouse button to click an item in the tree structure, Quick Devis® Free Edition 
automatically reclassifies the database according to the “User field” (or another field if in a private 
database) and point out the first article corresponding to the clicked item. The entire database is 
displayed, even the articles which does not match the item criteria. 
 
If, on the other hand, you use the right mouse button to click in the tree structure, the sorting key is 
not changed (you remain in “Description” mode if this was last active) and a filter is applied to return 
only the articles which correspond to the clicked item. The other articles do not appear any more on 
the screen. If you had earlier selected any article, the selection will be lost. 
 
To find one or more particular articles according to a key word which is not necessarily the beginning 
of the article’s name, sort the database according to the field of your choice and enter a filter in the 
appropriate text box. Then, accept the filter by pressing the <Enter> key. 
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Quick Devis® Free Edition will then return only the articles corresponding to the entered filter. If you 
had earlier selected any article, the selection will be lost. 
 
The syntax of the filters allows the use of the following characters: 
 

• * any character or digit (or several characters or digits) 
• ? any single character digit 
• # any single digit 
• [x-y] any digit ranging between x and y (x and y included) 
• [A-Z] any character or digit ranging between A and Z (A and Z included) 
• [!x-y] any digit except those ranging between x and y (x and y included)  
• [!A-Z] any character except those ranging between A and Z (A and Z included) 

 
Below are some examples when the database is sorted by “Description”: 
 

• *XM* (returns all articles containing “XM” in their description field) 
• Relay 2## V* (returns any article starting with “Relay 2” followed by two digits, then by a “V” 

and then by any data) 
 

The valid filters (those which return articles) are stored in the list of the last filters called (in the same 
text box). If you wish to clear the list of the recorded filters, click the “Filter” button and click the “Clear 
filters list” button. 
 
Only the last 25 valid filters used appear in the list. When you enter the 26th valid filter, the 1st one is 
automatically removed. 
 

Windows size 
 
You may open as many articles manager as the memory of your computer can handle. This function 
is particularly useful when you simultaneously use several databases. 
 
To open a second database, click again on the button  in the main window’s menu bar and select 
another database. You also can, if needed, open several instances of the same database. 
 
If, instead of clicking on button  in the main window’s menu bar, you click on the button  in an 
opened articles manager, the new database opens in the manager and not in a new window. 
 
This capacity of opening a significant number of databases often forces the user to reduce their 
window sizes so that they do not occupy the entire screen. Several buttons are proposed for this 
purpose: 
 

•  Displays or hides the tree structure at the left of the manager’s window 
•  Reduces the manager’s window to a size compatible with only one sorting column (in this 

mode, you can change the sorting order using the left and right arrow keys). 
•  Reduces the manager’s window to a simple menu bar, with no vision of any article (waiting 

database) 
•  Returns to the standard view 
•  Displays the manager in full screen mode and enables editing 
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When you close the articles manager, Quick Devis® Free Edition stores the sizing settings, the 
sorting key, etc. so, for the next opening, the database will take the appearance it had when you 
closed it. 
 

Inserting articles in the detailed view 
 
The insertion of articles in the detailed view can be done in the standard mode ( ), the reduced 
mode ( ) and the editing mode ( ).  
 
To insert an article, place the cursor on it and drag the article to the chosen row within the detailed 
view.  
You also can click the button  which will cause the insertion of the article before the detailed row 
on which the cursor is. 
If you press the button , the article will then replace the row on which the cursor in the detailed view 
is. This button can replace a selection of several rows if such a selection was first made. 
 
If you wish to insert a multiple selection of articles, you will have, in the articles manager, to select the 
articles one by one. To do so, you can double click on the articles or press the <Space> key. Do the 
same operation to deselect the articles. 
 
You can also enter directly the required quantities in the articles manager to avoid having to do it in 
the detailed view. To do so, place the cursor on the chosen article, keep the <CTRL> key pressed 
while entering the quantity. The typing of a quantity automatically causes the article to be selected. 
 
The selections of articles can be inserted in the detailed view using the same methods as those 
described for single articles (drag, insert  and replace ). 
 
Note: To deselect all the articles at once, click on the button . 
 

Editing the databases 
 
To set the “edit” mode, click on the button . In this mode, you cannot insert articles in the detailed 
view dragging them but only by pressing the buttons. 
 
Remember that you can also modify or insert articles directly in the detailed view of an estimate and 
record them or update them in the databases from the detailed view. This is a method generally more 
efficient than the direct edition of the databases. 
 
When switched to “edit” mode, the database appears in full screen with the following menu bar. 
 

 



Quick Devis® Free Edition                                                                                                               User’s Manual 
 

Quick Devis® Free Edition © IAES (1991-2006)                                                                                   Page 71/105 

 
You can then directly edit the fields by typing data in them. You can double click or press the F2 key 
to start editing a field. 
 
Please note the allowed formats: 
 

• Description ...............................................  250 characters maximum 
• Reference ..................................................  50 characters maximum 
• Family ........................................................  20 characters maximum 
• User Field ..................................................  20 characters maximum 
• Manufacturer .............................................  20 characters maximum 
• Unit ............................................................  10 characters maximum 
• Public price per unit ........................................  0 to 9’999’999’999.99 
• Currency ............................................. 3 characters in capital letters 
• Rebate ..................................................................................  0 to 95 
• Time per unit ..................................................  0 to 9’999’999’999.99 
• Kind of workforce ..................................................................  0 to 99 

 
If you wish to create a new article, click on the button , and change its characteristics by editing its 
fields.  
 
To delete an article or a selection of articles, select the articles to be deleted by placing the cursor on 
the left edge of the window and pressing the left mouse button, then click the button . To deselect 
the articles, use the same procedure. 

 
The edition mode also lets you optimize the database, meaning reducing its size to speed up access 
times. To optimize a database, click the button . This operation can also be launched from the 
“Tools” menu without having to open the database first. 
 

Creating or editing a tree structure 
 
To create or edit the tree structure of a private database, open the database in standard view ( ), 
click the tree structure button ( ) and click the edit tree button ( ). The tree structure editor is 
displayed as follows. 
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In the example above, we used the “User field” of the database to build the tree structure. The “User 
field” will thus be formatted, in this database, as X 00 000 followed by a sequence of numbers or a 
sequence of characters.  
 
The code A 01 002 001 will belong to “Gaz water heaters” and the code B 01 003 will belong to the 
“Electrical cabinets”. Below is the shape of the tree structure created. 
 

 
 

You can also use Microsoft Excel to create or modify your tree structures using the appropriate 
buttons in the tree structures editor. However, in such a case, it is recommended that you export an 
empty document to Excel starting from Quick Devis® Free Edition rather than creating one from 
Excel. This method guarantees that no formatting error will appear in the document to be imported. 
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You can also use the function “Database conversion tools” of the “Data” menu which lets you create 
article databases and automatically generate their tree structure starting from a Microsoft Excel 
worksheet. 
 
Note: The tree structure of Internet databases being compiled by the manufacturers; you cannot edit 
the tree structure of these databases. 
 

Exporting a database to Microsoft Excel 
 
To export the contents of a database to Microsoft Excel, click the button , from the standard view 
( ) or from the edit view ( ). Quick Devis® Free Edition lets you to specify what you wish to export. 
 

 
 
You can export all the articles of the database, only those which match the filter that you set up (*XM* 
for example) or only the selected articles. The function launches Microsoft Excel automatically and 
displays a standardized worksheet which can be modified under Microsoft Excel and be reconverted 
to a Quick Devis® Free Edition database using the “Database conversion tools” of the “Data” menu. 
 
Note: To protect data against unauthorized use, Internet databases cannot be entirely exported. This 
function is thus limited to private databases. 
 

Identification of the articles 
 
The articles of the private databases can be identified in two different ways: 
 

• Only with the field “reference” 
• With the fields “Description”, “Reference”, “Family”, “Manufacturer”, “User Field” 

 
When the field reference alone is used, you can modify the description in the database for example; 
the article remains always the same one for Quick Devis® Free Edition. In such a case, if you want to 
update an article from an estimate, the new description will replace the old one in the detailed view. 
 
Using this kind of databases implies that you provide references for each article. All references must 
be different, else you may import an article having a reference and, after an update, it might be 
replaced by another one having the same reference. 
 
You will choose this identification mode if you have a rigorous management of the data. 
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If, on the other hand, you wish to store your own articles without having to worry about the 
“reference” field, you will use databases which identify their articles on all the fields. In such a case, a 
simple modification of any of the key fields in the database will prevent Quick Devis® Free Edition 
from finding the article when updating. With this identification mode you can store articles even if they 
do not have any reference since they do have one of the key fields (Description, Reference, 
Manufacturer, Family, User Field). 
 
You can switch from one mode to the other by clicking on the button  (when the button is inserted, 
the references alone are used, when it is released, the 5 fields are taken into account). To reach this 
button, set the editing mode first using the button . 



Quick Devis® Free Edition                                                                                                               User’s Manual 
 

Quick Devis® Free Edition © IAES (1991-2006)                                                                                   Page 75/105 

The glossary 
 
Quick Devis® Free Edition proposes a glossary which behaves like a giant clipboard with 1’000 
memories. It should not be regarded as a database. Each memory can store up to 10’000 rows. 
 
To write data in the glossary, select the rows to be recorded in the detailed view and call the 
glossary. When rows are selected, the glossary opens in “writing” mode so you just have to select the 
memory number in which you wish to store your selection and click the “Write in glossary” button. 
 
Only the first line of each selection copied appears in the glossary. The glossary contains all the 
columns appearing in the detailed view, including the masked columns. 
 

 
 

To insert data from the glossary in the detailed view, call the glossary without selecting any row first, 
indicating that the glossary must be open in “reading” mode. Select the memory which contains the 
data to be inserted and click the “Insert in estimate” button .This will insert all the lines appearing in 
the selected memory. 
 
The data of the glossary are preserved on the disc and are stored in the user profile. Thus several 
users of the same computer can have different glossaries. 
 
You can create as many glossaries as you wish clicking the “Save glossary” button and providing a 
name. This name will then appear in the glossaries list and you will be able to switch from one 
glossary to another by simply clicking the list. 
 
To remove a glossary, click the “Remove a glossary” button and select the glossary to be deleted.  
 
To clear a memory in a glossary, select the desired memory number and click the “Remove from 
glossary” button. 
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The glossary being simply an advanced clipboard, it does not include data updating functions instead 
of the Internet databases. So if you paste data from a glossary memory after one year, you will get in 
your detailed view the data at the date where insertion in the glossary was made. If these data come 
from articles databases, you may want to update them using the “Update rows” function. 
 
If you need to read or write the glossaries from external programs, you must know that the glossaries 
are stored in files having a .GLO suffix and use the Microsoft Access format. 
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Setting prefixes 
 
Defining prefixes lets you quickly import data coming from the databases in the detailed view without 
having to open the databases first. The method used is described in the function “Replace by the 
article whose reference is mentioned”. 
 
To define prefixes, call the function: 
 

Set up searching prefixes  “Data” menu 
 

 
 

The prefixes can be entered clicking delicately on the text to edit the “Prefix” column. Then, 
Type 3 capital letters or 3 digit code prefix. You can assign prefixes to your own databases. 
For public databases, prefixes are generally suggested. 
 
When prefixes are set, click the “Ok” button to record them. You can restore the default 
prefixes clicking the “Reset” button. 
 
Note that the path number is always #9, which corresponds to the only definable path in Quick 
Devis® Free Edition. If you need more paths for you databases, consider using Quick Devis® 
Enterprise Edition. 
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Managing estimates 
 
In order to provide data for automated mails, you may enter information about the customer and the 
project. For this purpose, Quick Devis® Free Edition supports a database which let you store this 
information. This database which is common to all the estimates is automatically created using the 
“Configure an estimate” function in the menu “?”. This function is described in the chapter Configuring 
Quick Devis® Free Edition, at the beginning of this manual. 
 
If you did not configure Quick Devis® Free Edition, you can manually create the database clicking the 
“New customers’ database” button and providing a name in the management window. 
 
To call the management tool, click the button . The following window will appear. 
 

 
 

You can enter the fields manually or import them from the customers’ database clicking the “Import a 
customer” button and selecting the customer in the list. 
 
The new customers are automatically recorded in the database when you click the “Ok” button. 
 
You can click the headings of the customers’ lists to change their sorting order. You can sort 
customers by customers’ numbers, customers’ companies, customers’ addresses or contacts’ 
names. 
 
A customer is identified in the database by its number. This field is thus requested and you cannot 
record a customer who has exactly the same properties as another even if he has a different number. 
 
You can change customers’ database at any time by clicking the “Set customers’ database” and 
selecting a new customers’ file (.QDC) 
 
Customers’ database files (.QDC) are Microsoft Access files. You can create them or modify them 
using this program. However, in such a case, avoid usage of “Null” values in the fields. 
 
If you wish to manage your customers’ database, click the ‘Import a customer’ button to display the 
window as shown below: 
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Within this window, you can append customers, remove them or change their data by clicking the 
appropriate buttons. 
 
You also can export the whole database to an Excel file and import a customers’ file matching this 
format in a Quick Devis customers’ database. If you use this feature, make sure the input format will 
match the one expected by Quick Devis. The best solution consists in exporting an empty Excel 
frame from Quick Devis first, and then, completing it under Excel. 
 
If requested, you can re import an Excel file in an existing Quick Devis customers’ database. In such 
a case, customers’ data will be simply updated if the customers’ numbers match in the Excel file and 
in the Quick Devis database. 
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The Reports Generator 
 
The reports generator lets you print and export your estimates as you wish by using different 
presentations (profiles) of your estimates. 
 
A profile is a template which defines the appearance; it sets the displayed columns, the page 
headings, the detail level, etc. When a profile has been defined, it can be recorded and loaded from 
any estimate in order to produce a specific appearance. 
 
You do not need, when using Quick Devis® Free Edition to build your estimate in the manner you 
wish to present it: You will just have to load a specific profile into the reports generator so that the 
estimate will automatically take the profile’s appearance. 
 
The reports generator is a program integrated into Quick Devis® Free Edition which can be called 
using the function: 
 

Reports generator  “File” menu 
 

 
 
The reports generator offers several buttons which allow definition of the report to be produced. 
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Load profile   

 
 
This function displays a menu containing up to 25 profiles. They match the last profiles loaded 
or recorded. Simply click on the profile name to load it. The profiles appear in their order of 
use; most recent being on top of the list. 
 
If you load more than 25 profiles, the oldest will be pushed out of the list and the new one will 
take the top place. 
 
You can load a profile from the disc clicking the “Load report profile” button and selecting the 
desired file. 
 
You can also use the standard profiles delivered with Quick Devis® Free Edition clicking the 
“Show basic profiles” button. It is recommended that you use these profiles to create your own 
documents in order to avoid having to define all the settings. 
 
If you want to clear the list, click the “Clear profiles list” button. Then, the list will be 
automatically rebuilt progressively. 
 
Click the “Cancel” button to close the window and return to the reports generator. 
 
Reset profile  
 
This function lets you display a profile which will strictly conform to the Bill of Quantities 
entered under Quick Devis® Free Edition. The profile will have no heading. Use it to start 
defining a new profile. 
 
If you encounter a problem while loading a profile, use this function and retry in order to 
determine if the problem is in the estimate or the profile you are trying to load (if the report 
generator works with an empty profile, the problem is certainly in your profile). It will then be 
necessary to rebuild it. 
 
Kind of profile    

 
 
  You can display 3 different kinds of profiles using the reports generator: 
 

• The Bill of Quantities without detailed rows which comes with the same appearance as 
the B.o.Q. entered under Quick Devis® Free Edition 

• The Bill of Quantities with detailed rows which displays the B.o.Q. and the detailed rows 
of each task (the lines of the detailed view) 

• The detailed rows only which let you print the expenses as you want to see them and 
not necessarily as you entered them 
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To select a kind of profile, click simply in the appropriate drop-down list. 
 
Zoom    
 
This function lets you increase or decrease the size of the displayed profile on the screen. It 
does not affect the printed or the exported size. 
 
Show descriptions or task items on sub-totals   
 
This function, applicable to B.o.Q. based profiles only lets you include in the wording of the 
sub-totals the reference mark of the chapters (example: sub-total task: 1) or the first line 
constituting the description of the chapters (example: sub-total: Electric Components) 
The last solution implies that the description used in the first line of the chapter is not too long 
so that it can be displayed on one line. 
 
Rounding levels   
 
This function displays the rounding definition window (“Options” menu). When the roundings 
are defined, the report generator is displayed again with the new rounding settings. To set the 
round-offs, read the Rounding settings function in this manual. 
 
Amounts in words   
 
This function lets you display amounts in words under the amounts which appear in the report. 
It is applicable only to B.o.Q. style reports. You can display the amounts in several languages 
and place them under the amounts in figures. 
 

 
 

If you do not wish to use the default currency suggested, enter the usual names of your 
currency for its singular and plural forms. The hundredth of the currency should also be 
mentioned. 
 
Select the gender of the currency and the gender of its hundredth if applicable to the selected 
language. 
Specify the column which contains the values to be converted into words (I if the words relate 
to total prices and H if they relate to unit prices). 
 
Check the appropriate box if you wish the amounts in words to be preceded by the text 
appearing in the “unit” column. Example “The set: Twelve thousand euros”. 
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The two drop-down lists appearing at the bottom of the window let you specify the range of the 
wording conversion and the language to be used. 
 
Adjust line spacing  
 
This function lets you adjust the height of the blank rows. The displays are differents according 
to the profile from which it is called (B.o.Q. without or with detailed rows). 
 

            
 

In the first case, the function lets you specify the height of the lines between each task. In the 
second case, it lets you specify the row height in the detailed view. 

 
First page header  
 
This button lets you build personalized profiles by defining the heading of the first page and the 
structure of the profile. 

 

 
 

To define a specific profile, preferably get an empty profile (clicking on the button ) or a 
preset profile and click the button .  
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You can insert up to 50 rows clicking the button . Select the rows below the lines you wish 
to insert before clicking this button. 
 
You can then enter texts and values and format them using the button . You can also insert 
data resulting from the estimate to customize you profile according to the estimate from which 
it is called. To do so, click on the button . 
 
If you wish to set up borders in the heading, select the cells and click the button . 
n 
To display your logo, use the function  to import a .WMF file or more easily, copy and paste 
an image from Microsoft Excel or Microsoft Word. 
 
To display all available columns, click the button . To hide columns, select them and click 
the button . 
 
To return to the report view after definition of the heading, simply click again on the button . 
Record your profile under the name of your choice using the button . 

 
Next pages headers  
 
This button lets you define the heading of the pages starting from the second page to the last 
page of the document. Its operation is identical to that described for the heading of the first 
page. 
 
You can insert up to 10 lines in the heading of the next pages. 
 
Bottom pages  
 
Use this button to append some pages to your document. Its operation is identical to that 
described for the heading of the first page. You can place formulas and paste names in the 
bottom pages as you would do in the heading pages.  
 
Note: If you want to use a formula to be applied to the whole resulting document, make sure 
your formula includes the line 1. Example: SUM(I1:I10000) will return the total of the rows 1 to 
10’000 in the final document but the formula SUM(I2:I20) would apply to the bottom pages 
area only and will return the total of the rows 1’002 to 1’020 if the first row of the bottom pages 
is the row 1’000 of the final document. 
 
You can insert up to 500 lines in the bottom pages. 
 
Insert / Delete rows  (accessible in edit mode only) 
 
These buttons let you insert rows before the selected rows or to remove the selected rows. If 
no selection is active when these functions are called they relate to the last line of the heading. 
 
Cell format  (accessible in edit mode only) 
 
This button lets you define the format of the selected cells. You can set alignments, colours, 
borders, formats, etc. 
 



Quick Devis® Free Edition                                                                                                               User’s Manual 
 

Quick Devis® Free Edition © IAES (1991-2006)                                                                                   Page 85/105 

Paste a name   (accessible in edit mode only) 
 
This button lets you paste a variable which comes from the estimate in the heading of the 
profile in order to adapt the profile automatically regarding the estimate from which it was 
called. 
 
The data relating to the customer coming from management declaration in the estimate are 
available in this function (names, addresses, companies, etc) 
 
Set borders  (accessible in edit mode only) 
 
This button lets you define the borders of the selected cells. 
 
Insert an image  (accessible in edit mode only) 
 
This button lets you import a .WMF image (Windows Metafile) directly to the heading of a 
profile. 
 
If your image does not have a .WMF format, import it under Microsoft Excel or Microsoft Word, 
select it and copy it. Then, call the function  and select “Paste data from the Windows 
clipboard”. 
 
Important: Avoid using large images size to save printing time. A large image imported and 
reduced in the heading using the mouse is still a large image in memory. Thus take care in 
such a case to reduce it before importing it to the heading. 
 
Display all columns  (accessible in edit mode only) 
 
This button lets you display all available columns in a profile, including the costs columns. 
 
Hide columns  (accessible in edit mode only) 
 
This button lets you hide the selected columns. 
 
Cut  (Ctrl X - accessible in edit mode only) 
 
This button lets you copy and clear the selected cells. 
 
Copy  (Ctrl C - accessible in edit mode only) 
 
This button lets you copy the selected cells. 
 
Paste  (Ctrl X - accessible in edit mode only) 
 
This button lets you paste the cells previously copied in the selected cells. 

 
Font names  (accessible in edit mode only) 
 
This function lets you select a font name in a list. The font name applies to the selected cells. 
You can also type the name in the drop-down list.  
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Font size  (accessible in edit mode only) 
 
This function lets you select a font size in a list. The font size applies to the selected cells. You 
can also type the size in the drop-down list.  
 
Bold / Italic / underlined  (accessible in edit mode only) 
 
This function lets you change the typeface of the selected cells. You can use bold, italic or 
underline. 
 
Alignment  (accessible in edit mode only) 
 
These buttons respectively let you align left, center, right or center on several columns the 
texts appearing in the selected cells. Prefer this function which lets you center a text on 
several columns to the merging of cells because the latter cannot be exported to Microsoft 
Excel. 
 
Colours  (accessible in edit mode only) 
 
These buttons respectively let you modify the background colour and the font colour of the 
selected cells. You can also change the pattern of the cells. 
 
Tree view to be printed  
 
This function lets you select the branches to be hidden in the edition. This is useful when you 
wish to print chapters only. 
 

 
 

When branches are collapsed, a button “Expand all” lets you display the tree structure in 
conformity with that in the B.o.Q. 
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Managing Page breaks  
 
These buttons respectively let you insert a page break at the place where the cursor is and to 
remove the page break on which the cursor is. 
 
To move a page break, place the cursor on it and click the left mouse button. Keep the button 
pressed while moving the mouse to the desired location and release the button. 
 
You cannot move a page break outside a page. In such a case, Quick Devis® Free Edition 
automatically generates a page break to fit the calculated size. 
 
Important: The page breaks are valid only for the current session of the report generator. They 
cannot be stored in the profiles because those must adapt to any estimate. If you need specific 
functionalities which allow preserving page break positions, consider using Quick Devis® 
Enterprise Edition which lets you store the images of the reports in the estimates. 
 
Setting columns  (accessible in “Detailed rows only” mode) 
 
This function lets you define how the detailed rows should be displayed. Its operation is strictly 
identical to the function “Settings of detailed view or nomenclatures” described in the chapter 
Common functions in this manual. 
 
It is thus possible to arrange columns of detailed view in a completely different way from the 
one in which the estimates were built. These presentations are then stored in profiles you can 
use with any estimate. 
 
Display B.o.Q. rows or all the rows  (accessible in “Detailed rows only” mode) 
  
This function lets you include in the “detailed view” type profiles the text lines appearing in the 
Bill of Quantities, including those of the chapters. If the button is released, only the lines that 
refer to the displayed tasks are shown. 
 
When you display all the lines, you automatically get totals and sub-totals on each chapter and 
a grand total at the bottom of the estimate. 
 
Show gridlines  
  
This function lets you display the grid lines in a report. If the grid is visible on the screen, it will 
be also printed. 
 
Save profile  
 
This function lets you record the profile appearing on the screen with all its parameters. You 
can store your profiles wherever you wish. Quick Devis® Free Edition automatically appends 
recorded profiles to the list accessible using the button . 
 
Print  
 
This button prints the displayed profile. You can print in two different ways: directly or via 
Microsoft Excel. 
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The second method sends the document to Microsoft Excel and prints it using the Excel 
printing engine. This method can be interesting if you have to print huge documents because 
the Microsoft Excel printing engine is faster than the one of Quick Devis® Free Edition. 
 

 
 

The documents are printed according to the page settings defined using the button . You 
can specify the range of pages to be printed by using the appropriate check boxes. 
 
Page settings  
 
This function lets you select the printing device and the paper to be used. It also lets you 
define the text you want to print in the headers and footers of the documents. 
 

 
 

The “Print black & White” check box is particularly useful for printing clear black & white copies 
of coloured documents. 
 
All these settings are recorded in the profile except the name of the printer. For this reason, 
the loading of the profile automatically configures the page. 
 
The following codes can be used in the headers and footers: 
 

• &F (prints the name of the estimate file) 
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• &D (prints the date of printing) 
• &P (prints the page number) 

 
Note: You cannot print the total number of pages because in order to display rapidly the data 
(without requiring a complete pagination of the document) Quick Devis® Free Edition 
calculates progressively the position of page breaks while viewing or printing. If you wish to 
print the number of pages in the document, export it to Microsoft Excel first and place the code 
&N in its header or in its footer. 
 
Print preview  
 
This function lets you preview the document. You can move within the pages using the 
“Previous page” and “Next page” buttons or directly reach a page clicking the “Reach” button 
and providing the page number to be reached. 
 

 
 

The printing and page settings functions are available from the preview window. 
 
Quit  
 
This button closes the reports generator. While closing, the displayed report is memorized so 
as to be displayed automatically next time the reports generator is launched. 

 
Export to Microsoft Excel  
 
This function exports the displayed profile to Microsoft Excel with all its data and images. 
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In order to send the document to a customer for example, you can remove the hidden 
columns. If you wish to use the document to carry out calculations, you may consider removing 
the headings; check the “Remove page headers” box to do so. 
 
The “Transfer print settings” box lets you export to Microsoft Excel the entire data (colours, 
page settings, printing area, etc.) so as to get under Excel a document strictly in conformity 
with the displayed document. 
 
If you do not check the “Launch Microsoft Excel” box, Quick Devis® Free Edition will prompt 
you to provide a file name. 
 
The two bottom check boxes require Microsoft Excel version 97 or greater installed on your 
computer. 
 
Export to Microsoft Word  
 
This function lets you export the selected contents to Microsoft Word. 

 

 
 

The “Convert array to texts” lets you get text under Microsoft Word which can be directly used. 
If it is not checked, a table is transmitted to Microsoft Word. 
 
The second box lets you remove the “Total” and “Sub-total” figures which are generally not 
needed in a Word document. 
 
You can automatically launch Microsoft Word by checking the third box. 
 
This function requires Microsoft Word 97 or greater installed on your computer. 
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Automated mails 
 
The automated mails under Quick Devis® Free Edition are carried out by transmitting parameters to 
Microsoft Word. You need Microsoft Word 97 and Microsoft Excel 97 or greater to use this function. 
(Excel being used as a bridge for the communication with Word) 
 
To create your own automated mail without risk of error, the best solution consists in modifying the 
sample mail provided with Quick Devis® Free Edition. Do not try to launch the mail document in any 
other way than through Quick Devis® Free Edition because you might break the links. 
 
First of all, ensure that the macros are well activated under Microsoft Word by launching it and calling 
the “Tools / Macro / Security” function. Then select a level allowing the macro operations (low or 
average). Then, close Microsoft Word. 
 
Launch Quick Devis® Free Edition, open an estimate and enter some data in the management form 
(customer’s name, project’s name, etc.) calling the “Declaring estimate” function from the “Tools” 
menu. Then, call the function “Ms Word mail” from the “File” menu. 
 
Open the file named “Sample mail” which is located in the directory you chose for the standard mails. 
This directory was defined using the “Configure an estimate” procedure described at the beginning of 
this manual. If you did not carry out this procedure, you can directly open the sample mail from the 
Quick Devis® Free Edition installation directory (\Program Files\Quick Devis V6) 
 

 
 
Important: You must keep the <SHIFT> key pressed during all the opening process so that Microsoft 
Word will not merge the fields and thus, preserve the field codes. If a question concerning the 
execution of a request is posted, answer in the affirmative. 
 
The document appearing on the screen should be in conformity with the above model. Make changes 
to match your needs but never enter the field codes manually. To insert a field code, use the function 
“Insert merging field” located in the “Merging functions” toolbar of Microsoft Word. 
 
If the toolbar does not appear in the menu, click “Tools > Merging functions > Display toolbar” 
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You can also use the usual copy and paste functions to insert the merging fields by copying these 
fields from those which are proposed at the bottom of the standard mail document. 
 
When you have finished, it is imperative you record the resulting document under a Word model 
format (.DOT) and not as a document (.DOC). Preferably save this document in the directory defined 
to receive standard mails (“Options > Default settings”) under Quick Devis® Free Edition. 
 
To use your new mail template, simply call the “Ms Word Mail” function in the “File” menu and select 
your model without pressing the <SHIFT> key. Answer in the affirmative if Word ask you to launch a 
SQL request. You should then obtain a document as follows: 
 

 
 
If the merging function has not worked and you get a document with the fields instead of their 

contents, press the  button under Word and ensure that you strictly followed the procedure 
described above for the creation of the document and check that the .DOT model created matches 
the data located in the file named QDWORDFS.XLS (in the same directory as the model). Also make 
sure that the macros of Microsoft Word are activated. 
 
To check the links to QDWORDFS.XLS file, open the .DOT file from Quick Devis® Free Edition 
keeping the <SHIFT> key pressed according to the procedure described above and click the “Open 
data source” in the “Merging tools” bar. Then, select the file QDWORDFS.XLS which is in the same 
directory as the model and specify that you want to use the first sheet of the Excel workbook as a 
data source. Accept and record your model in a .DOT format. 
 
Important advice: Use as a model for all your standards letters the sample file provided with Quick 
Devis® Free Edition which is located in the installation directory \Program Files\Quick Devis V6\). 
Using this model, you should not meet any problem while merging, even if you move the resulting file. 
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Indeed, this sample file contains VBA macros which automatically detect the installation directory of 
the file and will locate the data source. 
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The safety of the estimates 
 
In order to offer an optimal safety, the changes you operate in your estimates are recorded “in line” in 
the file. However, this file is a temporary file which resides on your local hard disk in order to offer 
good performances. 
 
The principle used while opening an estimate is as follows: 
 

1. Quick Devis® Free Edition checks that a copy of the file requested (which might have been 
closed in an incorrect way) does not already exist in the “cache” directory. In such a case, it 
would directly open the file form the “cache” with a message announcing that the file was 
recovered. 

2. If not, the .DVZ file selected is expanded into the local “cache” directory (making a simple copy 
if it is a .DEV file) 

3. It opens the expanded file located in the “cache” directory 
4. It writes a flag indicating that the file was closed in a wrong way in anticipation of a possible 

problem. 
 
The principle used while closing an estimate is as follows: 
 

1. Quick Devis® Free Edition compresses the estimate (which is located in the “cache” directory) 
to a temporary file which will be placed in the “Last Save QDV” directory. 

2. If the process of compression worked correctly (checking of the integrity), Quick Devis® Free 
Edition will copy the resulting file to its initial location with a temporary suffix. 

3. If the process of copying worked correctly, Quick Devis® Free Edition will delete the original 
file and will assign the name of the original to the file copied. 

4. Lastly, it will mark the .DVZ file recorded with a flag meaning that it does not contain any errors 
in order to avoid opening it from the “cache” directory at the next opening. 

 
The principles described above prevent you from any risk of loss of data. If however you wish to 
restore a former version, call the “Recover an estimate” function in the “Tools” menu which enables 
you to retrieve tracks of all your recordings. 
 
These safety tracks are stored in stacks whose size is defined using the “Performances and Safety” 
functions in the “Tools” menu. They are necessarily placed on a local disc in order to offer good 
performances. The files are placed in the user’s profile directory (generally C:\Documents and 
Settings\<user’s name>\Application Data\Quick Devis\) 
 
The safety directories are: 
 

• CacheQDV (work directory) 
• LastSaveQDV (stack for last saved files) 
• RecoverQDV (original files which have been recovered or repaired) 

 



Quick Devis® Free Edition                                                                                                               User’s Manual 
 

Quick Devis® Free Edition © IAES (1991-2006)                                                                                   Page 95/105 

The formats of estimates files 
 
Quick Devis® Free Edition manages two different formats for the estimates, .DVZ files and .DÉV 
files. 
 
The first are compressed estimates in ZIP format, the second are expanded estimates (with Microsoft 
Access format) and they can be read directly under Microsoft Access. 
 
When you create a new empty estimate, an expanded file (.DEV) is automatically created; it is then 
transformed into a compressed file (.DVZ) with the first recording. The original .DEV file is removed if 
the compression process ended successfully). 
 
If you wish to open a .DVZ file under Microsoft Access, you will have to expand it first. To do so, use 
the “Compression tools” function in the “Tools” menu. 
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Converting an Excel file to a database 
 
Quick Devis® Free Edition lets you export an article database to Microsoft Excel and convert an 
Excel workbook to an articles database so as to use for example tariffs you have obtained in an Excel 
format. 
 
To carry out such a conversion, you must create an empty frame which you will have to fill using copy 
and paste functions under Excel. To create an empty frame, call the function: 
 

Create an empty frame  “Data” menu 
 
Save the frame generated with a new name and open the file which contains your data. 
 

 
 
Using successive copy / paste operations fill each column. Do not forget to fill the “Currency” field 
with a 3 character code. 
 
If you wish, you can associate a tree structure to your database by filling the “Tree View” sheet of the 
Excel workbook. 
 
To create a coherent tree structure, read the Creating or editing a tree structure function in the 
chapter The Articles Manager. 
 
Specify to which field your tree structure must be linked by typing the character X in the appropriate 
cell. 
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When your Excel workbook if filled, save it and call the function: 
 

Convert a frame  “Data” menu 
 
Select the Excel file you recorded, click the “Convert” button and provide a name for the new 
database. Place it in the directory you indicated to receive the databases. 
 
If the conversion process is successful, you will simply get the message “conversion terminated”. If it 
failed, an error message will be posted and the column N will contain a specific error message for 
each row containing an error. Correct these errors and launch the operation again. 
 
If the database specified already exists, Quick Devis® Free Edition will prompt you to replace it or 
add the new articles to the database. In this last case, the articles will be added only if they did not 
exist already in the original database. About this, remember that articles are regarded as identical in 
a private database since their 5 key fields are identical (“Description”, “Reference”, “Family”, 
“Manufacturer” and “User field”). 
 
You can carry out the opposite operation at any time by opening the database under Quick Devis® 
Free Edition and exporting it to Microsoft Excel. 
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Converting an Excel file to an estimate 
 
Quick Devis® Free Edition lets you quickly convert a Microsoft Excel file to an operating estimate. 
 
You must prepare the Excel file as follows: 
 

 
 
The description must appear in the column C and must never exceed 255 characters. The unit will 
appear in the column D without exceeding 10 characters. The quantity will be in the column E in a 
numerical format with or without decimals. The item of the task will be placed in the column B using a 
text format and will not exceed 15 characters. 
 
Column A will be necessarily codified according to the “depth” of the tree structure of the estimate. 
The values can range from 0 to 7 and match their overlapping level in the structure. Thus, in our 
example, line 1 will be the title of the estimate (you cannot have a level zero), lines 2 and 22 will 
match chapters and lines 3, 10 and 16 match sub-chapters. 
Lines 5 to 9, 11 to 15, 17 to 21 and 24 to 28 are terminations of branches and thus correspond to 
tasks to de detailed in the detailed view. 
 
You can insert between two tasks or chapters as many lines as you wish as in the example above in 
lines 4 and 23. The data of these lines will belong to the tasks which “carry them” (the tasks 
appearing in lines 3 and 22 in our example). 
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After coding, you can convert the file to an estimate using the following function: 
 

Convert an Excel file to an estimate  “File” menu 
 
Simply select the Excel file to be converted and you will get an estimate file immediately. When the 
file will be converted, you will have to import you usual environment settings using the function “Get 
settings from another estimate” in the “Tools” menu. 

 
During the conversion process, Quick Devis® Free Edition preserves most of the attributes appearing 
in the column C: italic, bold, underline, font sizes, font names and font colours. The possible 
backgrounds or patterns of cells are not reproduced. The attributes of the other columns are not 
considered. 
 
Important: Quick Devis® Free Edition does not support all features of Excel files and in particular the 
macros, the pictures and the charts. In order to ensure a perfect conversion, it is recommended that 
you start from a new Excel workbook and paste data in it using the function “special paste / values 
only”, then “special paste / formats only” without copying the entire page but only the necessary cells. 
These operations ensure that the resulting Excel file will be free from any object which could not be 
supported by Quick Devis® Free Edition. 
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Troubleshooting 
 
No amount appears in the overhead sheet when data was entered in the detailed view 
 
Check that you entered a quantity on each task in the B.o.Q. and that each branch (chapter) also has 
a quantity in the B.o.Q. 
To make sure quantity will be equal to 1 in all the branches without having to type them, you can 
check the appropriate box in the “Options > Display tree view” menu. 
 
Quick Devis® Free Edition is not stable and stops frequently without apparent reason 
 
If frequent instabilities are noted, it is probably because a program was installed subsequent to the 
installation of Quick Devis® Free Edition and altered some of its components. In this case, the best 
solution consists of completely removing the program using the “Uninstall Quick Devis® Free Edition” 
function in the “Start” menu. Specify “Uninstall manually” click then “Select all”, then “Next” until the 
procedure comes to an end. This manual method ensures that all of the components of Quick Devis® 
Free Edition are removed. Then, reinstall the program normally. 
 
Quick Devis® Free Edition seems to be extremely slow during the creation of an estimate 
 
Quick Devis® Free Edition uses the Microsoft Jet data engine which is also the engine of Microsoft 
Access. Access to this engine can be controlled in real time by certain antivirus programs or by 
remote programs being on your networks. These tools can considerably slow down the access. First 
of all, disconnect your computer from the network, close the session, open a new one and start Quick 
Devis® Free Edition again. If the problem seems to be solved, contact your network administrator 
who will be able to solve the problem by changing the safety settings. If the disconnection from the 
network does not solve the problem, change your local antivirus settings so that it does not filter the 
exchanges between the programs and the local disc but only the exchanges with the outside. 
 
The article databases cannot be opened 
 
If you cannot open an article database, try to repair it using the function “repair an estimate or a 
database” from the “Tools” menu. You can also compact it using the function “Compact an estimate 
or a database” from the “Tools” menu. 
If it is an Internet database, its access may be refused to you because you are trying to use a 
database on a different computer from which it was ordered. Contact your database provider to get 
rights for your computer. 
 
During the conversion of an Excel form, the file cannot be read 
 
It is recommended to start a conversion from a new Excel workbook and to paste the data to be 
converted using the “Special paste / Values only” and “Special paste / Format only” functions. Never 
copy the entire sheet from your original document. Only copy the necessary cells. These operations 
ensure that the resulting Excel file will be free from any object which could not be supported by Quick 
Devis® Free Edition. 
 
During the conversion of an article database, the Excel file cannot be read 
 
In order to ensure a correct conversion, it is essential to export an empty workbook first using the 
appropriate function of the “Data” menu and to paste the data to be converted using the “Special 
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paste / Values only” function. Avoid creating an empty Excel workbook; always use one which was 
exported by Quick Devis® Free Edition. 
 
The loading of a profile in the reports generator causes the error “Cannot read the clipboard” 
 
The problem probably comes from the profile you loaded which has an anomaly or which cannot be 
completely loaded into the memory. To check it, reset an empty profile clicking the appropriate button 
of the reports generator. Close the report generator with this new profile. If the problem seems to be 
solved, recreate the report starting from the empty profile, record it and delete the profile which does 
not work. In order to load profiles quickly, even on systems equipped with large memory, avoid 
employing large images which you would have to reduce in the reports generator. Reduce the 
images using a graphic program before importing them in Quick Devis® Free Edition. 
 
The selling prices are not calculated 
 
If the selling prices are not calculated and the “#N/A” is displayed in the B.o.Q. your estimate is 
probably damaged. In such case, try to repair it using the “Repair an estimate or a database” function 
of the “Tools” menu. Then reindex your estimate and compute it. If the problem is not solved, return 
to a previous version of your estimate using the function “Recover an estimate” from the “Tools” 
menu. 
 
I cannot load an estimate previously saved 
 
Your estimate is probably damaged. In such case, try to repair it using the “Repair an estimate or a 
database” function of the “Tools” menu. Then reindex your estimate and compute it. If the problem is 
not solved, return to a previous version of your estimate using the function “Recover an estimate” 
from the “Tools” menu. 
 
When trying to update public databases, some cannot be downloaded 
 
This is probably caused by damaged databases on your computer and Quick Devis® Free Edition 
cannot mix them with the remote databases. Start repairing the databases using the “Repair a 
database or an estimate” and “Compact a database or an estimate” functions from the “Tools” menu. 
Then, retry to update you databases. 
If it fails again, backup them if they contain personal information such as work times or kinds of 
workforce and delete the databases which caused the problem. 
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Comparing Quick Devis® Free Edition and Quick Devis® Enterprise 
Edition features 
 

Feature Free Edition 
Enterprise 

Edition 
Estimate     

Size of the Bill of Quantities 

Up to 250 tasks 
out of 65000 

lines 

To 32000 tasks 
out of 65000 

lines 
Viewing of the B.O.Qs in condensed mode No Yes 

Capacity of the detailed view 
10’000 rows per 

task 
10’000 rows per 

task 
Customization of the detailed view Yes Yes 

Customized fields in the detailed view (weights, volumes, 
specific calculations) No Yes 

Nomenclatures multi classifications 

Yes - Reporting 
only and current 

estimate only 

Yes, interactive 
and multi 
estimate 

Open export to management systems (SAP, Oracle 
Application, etc.) No Yes 

Reorganization of structure by drag and drop Yes Yes 
Copy / Paste tasks or entire branches from one estimate to 

the other Yes Yes 
Colour markers Yes Yes 

Management of the options 
By changing of 
quantity only 

By assignment of 
quantities or 
installation in 

specific 
document 

Forcing of selling price in the B.o.Q. No Yes 
Forcing of coefficients in the B.o.Q. No Yes 

Automatic compensation safeguarding margins No Yes 
Definition of specific columns in the B.o.Q. No Yes 

Export to Microsoft Excel Yes Yes 
Importation from Microsoft Excel Yes Yes 

Dynamic synchronization with external Microsoft Excel 
workbooks No Yes 

Bidirectional integration of paper frames by scanning No Yes ** 
Group working on the same estimate No Yes 

Management of round-offs Hundredth to ten 
Hundredth to the 

million 

Dynamic specifications linked with Microsoft Word objects No Yes 
Automated mails (letters, invoices…) Yes Yes 

 
Export of gantry statements, invoicing for progress 

payments, etc. No Yes 
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Safety by passwords No 
 

Yes 
Databases     

Web databases 
Yes, Internet ** 

only 
Yes, Internet ** 
and/or Intranet 

Private databases Yes Yes 
Virtual databases Not Yes 

Group databases No 

Yes, unbounded 
of complexity in 

the logic of 
importation 

Glossaries 

1’000 memories 
per glossary, 
10’000 lines 

maximum per 
memory, a 

unlimited number 
of glossaries 

1’000 memories 
per glossary, 
10’000 lines 

maximum per 
memory, a 

unlimited number 
of glossaries 

Technical Configurators Yes*** Yes*** 

Number of database paths 1 (local only) 10 (networked) 
Number of databases Unlimited Unlimited 

Database size 

2 giga bytes 
maximum by 

base 

2 giga bytes 
maximum by 

base 
Personal management of the rights No Yes 

Import / export of the databases to / from Excel Yes Yes 
Importation SQL Server, Oracle application, etc. No Yes 
Management of the rebates for web databases Yes Yes 

Management of contextual rebates No Yes 

Forced selling prices in the databases (call-of contracts) No Yes 
Tree structures in the databases Yes Yes 

Microsoft Excel workbooks in the articles (dynamic 
calculations) No Yes 

Microsoft Word documents in the articles (technical 
specifications) No Yes 

Actualization of the articles from the detailed view Yes Yes 
Recording of the articles from the detailed view Yes Yes 
Generation of databases specific to an estimate No Yes 

Actualization of lines from a selection Yes Yes 
Global actualization of an estimate No Yes 

Importation and calculation of Excel documents in the 
detailed view No Yes 

Search for articles by filters Yes Yes 
Automatic positioning in the databases starting from an 

article in the detailed view Yes Yes 
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Requests in open language in the articles databases No Yes 
Extended fields in the databases (weight, volumes, etc.) No Yes 

Optimization of the data bases Yes Yes 
Overhead costs workbook     

Calculations of environment 
Yes, pre 

configured 
Yes, completely 
customizables 

Compatibility with Microsoft Excel in export Yes Yes 

Support of the currencies 
Yes, up to 99 per 

estimate 
Yes, up to 99 per 

estimate 

Qualifications of material and subcontracting No Yes, up to 99 

Qualification of the workforce resources Yes, maximum 3 Yes, up to 99 

Automatic determination of the coefficients of sale No 

Yes, 3 different 
and 

customizable 
methods 

Assignment of the coefficients of sale 
Yes, maximum 4 

per estimate 
Yes, maximum 

200 per estimate 
Free sheets in the overhead expenses workbook No Yes, up to 22 

Importation of Excel workbooks in the environment No Yes 
Breakdowns by families in the overhead workbooks Yes Yes 

Breakdowns by user fields in the overhead workbooks No Yes 
Breakdowns by manufacturers in the overhead workbooks No Yes 
Breakdowns by extended fields in the overhead workbooks 

(weight, dimensions, etc.) No 
Yes, 

customizable 
Project management     

Management of the customers 
Yes, in a local 

database 

Yes, on local or 
network 

databases 

Data specific to the estimates (description, standards) Yes 
Yes, with 

centralization  

Centralized management of the estimates, the customers, 
the engineers and the kinds of businesses No 

Yes, locally, or 
on a network 

Automated Microsoft Word mails starting from management 
data Yes Yes 

Support of the revisions of the estimates No Yes 
Reports, profiles     

Generator of customizable reports Yes Yes 
Regrouping of branches in the reports Yes Yes 

detailed rows in the reports Yes Yes 
Ability of hiding retail prices No Yes 

Addition of customized columns in the customers’ reports No Yes 
Personalization of the columns in the costs reports Yes Yes 
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Specific customizable calculations fields in the columns of 
the costs reports No Yes 

Maximum number of reports Unlimited Unlimited 
Storage of reports in the estimates (photo / albums / 

traceability) No Yes 
Multilanguage amounts in words in the reports Yes Yes 

Sorted reports for call-off contracts No Yes 

Customized report (not correlated with the B.o.Qs) No Yes 
Structured customizable tree views in the reports No Yes 

Export to Microsoft Excel Yes Yes 
Export to Microsoft Word Yes Yes 
Direct export to emails No Yes 

 
 
 
 


